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Preface

Thank you for buying our products. Our machine is professional and
high-technology equipment combined with the optical, mechanical and electrical; here

especially edit this manual for your good operating and maintenance.

We also take many real object photographs in the manual; it helpfully introduces

installation & adjustment, maintenance, safety attention etc. in details.

The user should read this manual in details before using, because it will help you

have a good grasp of operating and maintenance.

Welcome to provide your valuable comments or suggestions, will highly

appreciate it!
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| Manual of laser machine

Statement

1. Any differences are not specially notified in advance for products update etc.
reasons.
2. All products according to the real object, manual's photograph maybe different with

real object for products update etc. reasons.
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Safety Note

* The users should read the related operating manual carefully before operating. Must
obey the operating regulations strictly. Non-trained people are forbidden to operate
machine.

% The machine uses IV LASER (strong laser radiate), this kind laser radiation might
make following accidents:

(DEasy to burn around combustible materials; @Different working materials might
produce other radiations and toxic or harmful gases during laser processing; (3Laser
radiation's direct sunlight will cause body harm;

The machine location must equip fire-fighting equipments, so forbidden something
combustible and explosive around the machine, keep drafty. Non-trained people are
forbidden to operate the machine.

% Processing material and emission should conform to local laws and regulations

% The user should consider carefully whether processing materials are suitable for
laser working for risk reason.

% There are high-voltage and other potentially dangerous in the machine, non
professionals are forbidden to disassemble machines.

% The operator is forbidden to leave during operating and must cut off switch when
finishing work.

% Forbid open any cover during working.
% Make sure the wire connects well with the ground before operating.

% Forbid the things inconnected diffuse reflection around the machine for fear the
laser light reflect the person or incendive directly (advice use firehosereel box in
location of working).

% The operator must observe carefully during the working of machine, if something is
exceptional, should cut off all the switch.

% Keep the machine in the dry place, non-pollution, non-concussing, non-strong
electricity, strong magnetism etc., environmental temperature should be 5-40°C,
environmental humidity should be 5-95%(no condensed steam).

% The laser machine needs far from sensitive EMI equipment, it will make EMI to this
kind equipments.

% The working voltage: AC220V/110V, it is forbidden to open machine when the
power supply voltage is unsteady or mismatch.

Manufacturer won't take any responsibility and liability because of improper use and
user not obey above all regulations.
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| Chapter 1 Machine Appearance and Accessories

1.1 Machine Appearance (Different model will have different appearance, according

to the real object)

1. Right side 1s shown in Fig.F1-1

1-1
2. Back side is shown in Fig. F1-2

/'g\ FR—
e

F1-2
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1.1.2 Accessories set (according to the real object)
Your accessories set include following parts except machine (except option spare
parts)

1. Water pipe (air pipe), Air pump, Water pump (some installed in water tank), is
shown in Fig. F1-3:

&S RESUN " [1%F
LECTROMAGNETIC
EIR rPUMP

F1-3

2. Exhaust fan, smoke pipe, is shown in Fig. F1-4:

F1-5

4. Water tank (less model not provide water tank), is shown in Fig. F1-6:
5
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F1-6

5. Manual Bag and inside accessories, is shown in Fig. F1-7:

F1-7

F1-8
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| Chapter 2 Installation and Commissioning of the Machine

A complete working system is composed by laser engraving machine, the exhaust fan,
air pump, water pump, water tank, exhaust pipe, data transmission lines and so on.
According to the needs, the users can configure the computers, printers, scanners and
so on by themselves.

2.1 Installation and Adjusting Steps

1. Laser Tube Installation

As the laser glass is fragile goods, the laser tube should be packed separately in order
to ensure its safety during the transportation. So the users must install the laser tube
before machine installation and commissioning.

Laser tube should be mounted on the back of the machine, open the protective cover of
laser tube; you can see the two Vee-blocks. As shown in Fig. F2-1:

R g e TR

F2-1

Put the light-emitting window (low-voltage end)of laser tube with the same side of
No.1 reflector mirror on the Vee-blocks carefully, and then latch on the rubber strip on

7
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the Vee-blocks wear of laser tube , fix laser tube well. As shown in Fig. F2-2:

F2-2

Attention: (DThe laser tube can’t be fixed too tightly to avoid damaging it; @Be sure
to keep the water inlet (laser tube high-voltage side) is located at the bottom of tube to
keep the water filling the laser tube fully.

After Fixed the laser tube, the water inlet pipe which connect with water sensor should
be connected with the high-voltage side water inlet mouth of the laser tube; the water
outlet pipe should connect with the low-voltage water outlet mouth of laser tube (if the
weather is cold, ,in case of break the laser tube, we’d better scald the end of the water
pipe with boiled water to make it soft. ),As shown in Fig. F2-3, F2-4:

F2-3 F2-4

All the connectors must be butted firmly to prevent water leakage. The rubber pipe
must be straight, can not be curled in order to avoid poor water flow.
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Finally, let the high-voltage cable of the laser power supply connect to the
high-voltage side post head of laser tube, the low-voltage cable of laser power supply
connect to low-voltage side post head of the laser tube, as shown in Fig.F2-5 F2-6:

F2-5 F2-6

For security, please seal the post head of the high voltage side and low voltage with
silicon gel.

.2. Water Pump Installation

Please fill pure water into the water tank (the water level should be higher than the
pump at least). Let the water pump outlet connect to water inlet of the machine, using
another piece of water pipe connect to the water outlet of the machine ,and put the
other side of this water pipe into the water to complete the circulating water piping
connection. As shown in Fig.F2-7, F2-8:

F2-7 F2-8

Connect the water pump power supply, at this time we can see that the laser tube is
gradually filled with water. If the water can through the water outlet pipe smoothly, it
shows that the pump is working properly.
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In order to ensure the cooling water flow of the laser tube normally, a water protection
sensor is installed in the water recycling system, when water pumps working poor or
abnormal, the laser engraving machine will come into the protection state
automatically. Then the laser tube will not emit the laser light. Therefore, in the course
of routine maintenance, you should pay attention to the clean water pumps and water
pipes.

3. Installation of Air Pump

Make the air outlet of the pump connected to the air inlet of the engraving machine
with air pipe; ensure the outlet can vent air normally after turn on the power. As
shown in Fig. F2-9, F2-10:

F2-0 F2-10¢

Air pump is very important in the system. High-pressure air runs through the air pump
and blew out from the laser light-emitting window of the laser head. On the one hand,
it can ensure the cleanliness of the focus lens, on the other hand, it can prevent the
material inflame by the laser light. Therefore, in the routine maintenance, the user
should pay attention to the air pipe, must ensure that it cannot be twisty or damaged,
otherwise abnormal air may lead to burning materials.

4. Installation of Exhaust Fan

First, let the suction inlet of the exhaust fan connect to the dust suction outlet of the
engraving machine by a smoke pipe, and fix them with lock. And then take another
smoke pipe connect the outlet of the fan, and put the other end of smoke pipe to
outside. At last, connect the power supply wire well. As shown in Fig.F2-11, F2-12:

10
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F2-11 F2-12
5. Safety Grounding

Morn laser engraver uses fourth type of laser tube. The type of drive is
high-voltage-driven, so during users use the machine, they must comply with the
"Safety Note ". On the other hand, it asks stringent requirement about the safety
grounding to the users. The safe Line-to-Ground Resistance should be less than 5Q.
Specific connection method is shown in Fig. F2-12, F2-13

GROUND LINE

Computer

Laser Machine

F2-12 F2-13

Attention please, bad grounding can cause high failure rate of equipment and at
the same time may cause other safety incidents! ! !

The company won’t assume any responsibility and obligation to the fault and the
accident caused by bad grounding!!!

11
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6. Optical Path Adjustment

After let all power cables connect well and electrify, turn on the engraving machine
power supply, at this time, the machine starts to reset and return to the last origin

point . All above shows that the machine is running normally, then turn on the laser
power supply, begin to adjust the optical path. As shown in Fig.F1-14:

e
i * e o 28

F2-14

Firstly, adjusting the laser position. Make the multilayer adjusting paper stuck on the
1# mirror frame, and then push the "Pulse" key on the control panel. There will be a
burned point in the paper, check whether the light spot is in the center of the mirror, if
the light spot is not in the center o f the mirror center, we have to make the light spot
in the center of the mirror by regulating the location of the laser tube.

Then adjust the 1# reflector mirrors. Move the beams to the nearest place to the
1# reflector; push “Pulse” to get a spot in the paper. And then move the beams to the
farthest place from the 1# reflector, get another spot in the paper. We adjust the angle
of the mirrors by adjusting the three screws on the back of mirror (clockwise rotation
the above screw, the spot will be down; clockwise rotation of the lower left corner of
the screw, the spot will move to right; clockwise rotation of the lower right corner of
screw, the spot will move to left.), to insure that all the spot are in the same place in

the paper when and where the beam we move.

After adjust the 1# reflector mirror well, the next, adjust the mirror 2# as we do at
12
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the first step, move the laser head to the nearest side to 2# reflector , then make a spot
in the paper , then move the laser head to the farthest place to 2# , make a spot. We
have to adjust the further spot overlap with the first spot by adjust the screws on the 2#
reflector frame.

Note: As the best, the location of light spot should be in the center of mirrors. The
light spot cannot hit the edges of the mirrors. If playing in the edges, please
continue to adjust the mirrors until the light spot in the central of them.

At last we have to check whether the light spots are superposition wherever the
laser head is. If the spots cannot coincide, please re-adjust the optical path by the way
we talked above until the spots coincide

After finished the adjustment, we will check whether this laser spot is playing in
central of the laser head light hole. If not, turn off the laser power supply, adjust the
laser tube position. If it is left and right excursion, which side is biased on, we move
the laser tube to this side direction. Such as: if left, we adjust the laser tube to left ; if
right , we adjust the laser tube to right .

If the migration is up and down, we have to adjust the laser tube to the opposite
direction, that is, if up, we will make the laser tube down; if down, we will make the
laser tube up.

Note: The above adjustments is just for a low-voltage side of laser tube (light side),
if we want to adjust high-voltage side of the laser to achieve the same effect, then
the adjusting direction is opposite.

The detailed description of how to adjust optical path, please refer to I Chapter 4
"Alignment Standards of Optical Path".

After adjustment of optical path, please close the laser tube protective cover.

13
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I Chapter 3 the Operating Instruction of Panel

3.1 Introduction to the Panel and Keys

3.1.1 The whole panel

Enter

Origin Frame
onomBe

Pulse Speed MinPower  MaxPower File Start-Pause

Reset

3.1.2 Introduction to the Keys

0‘ :Reset the whole system
o . :Set the relative origin;

® . :Let the Laser to splash;
. &

:To track by the current file’s frame;
[ - :The management of the memory and U disc files;

° - :Set the speed of the current running layer, or set the direction keys’

14
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Move speed;

° . :Set the max laser power of the current running layer, or set the power

of “Laser” Key;

o . Set the min laser power of the current running layer

® (pPause’/ :To start or pause the work;

o - .:To move the X axes or the left/right cursor;
o n n :‘To move the Y axes or the up/down cursor;

° @ :The Z/U key can be pressed when the system is idle or the work is
finished. On pressing this key, it will show some entries in the interface, each
entry includes some functions, Z axes move, U axes move, each axes to go

home etc.;

° .To stop work, or to exit to some menu;

° : Validate the change;

3.2 Introduction to the Main Interface

3.2.1 The main interface

15



User’s Manual of Laser Engraving / Cutting machine

When the system is powered on, the screen will show as below:

Running
parameters

Graph display
area

¥ \ File:\ 01
Speed: 300mnys
MaxPow : 30.0%/30.0%
/—\ X 1502 ol
Y: 153.5 — -
\\\\‘—’//// 2 3000 mnl\\w Coordinate
01 400 25.0
g; fgg 2921 Graph layer
Running ‘ arameters
progress bar ;
\\\\\ij:; —
/Idle 00.00. 00 Count://99X : 180.5 mm Y: 235.6 mm connect
T~ ~—
Running Working ‘\\\\j:=;i1e dimension Net Status
Status Number

Figure 3.2-1
® Graph Display Area: To display the whole file’s track, and display the running track.
® Running parameters: To display the running file’s file number, speed, max power etc.;
® Coordinate: To display the current coordinate of X,Y and Z axes

® Graph layer parameters: To display the layers’ information of the current file, such as max
or min power, speed etc.. When system is idle, dblclick the layer, then users can change the

layer’s parameters and the changing would be saved.

® Running Status: To display the current status of the machine, such as Idle, Run, Pause,

Finish, etc.;
® Running Progress Bar: To display the progress bar of the current running file;
® Working Number: To accumulate the work number of the current file.
® File Dimension: To display the dimension of the current file;

® Net status: To display the connecting status of the Ethernet.

When work is Idle or finished, all keys can be pushed, users can select a file to run, set some
parameters, preview to a select file etc. But, when work is running or paused, some keys don’t

respond when they are pushed.

16
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3.2.2 Speed key

Push the “Speed” key when the screen is on the main interface, it will show as below:

Speed: - mm/s

Modified press Enter

Figure 3.2-2

Push the “X+/-“ Keys to move the cursor in the numeral area, and push the “Y+/-” keys to
change the value, then push the “Enter” key to save the change, push the “Esc” key to invalidate the

change.
3.2.3 Max/Min power keys

Push the “Max Power” or the “Min Power” keys when the screen is on the main interface, it will

show as below:

MaxPowerl:;

_ % MinPower]: _ %
MaxPower2: % MinPower2: | 30.0| %

Press Z/U move item Press Z/U move item
Modified press Enter Modified press Enter
Figure 3.2-3¢ Figure 3.2-4¢

When “Z/U” key is pushed, the green block can move up and down to denote the changing item,

then “Y+/-" keys and “X+/-" keys can be used to change the value.

17
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3.2.4 Set the layer parameters

After selecting a file to preview on the main interface, user can push “Enter” key to let the cursor
move to the first layer, then “Y+/-” Keys can be pushed to select the intent layer, on that time, user

can push “Enter” key to check the selected layer’s parameters, show as below:

Speed: 400 |mm/s
MinPowerl : %

MinPower2:

ol |waf |ro
===
s
)

200 29.1 MaxPowerl : %
100 31.5 MaxPower2: %
Press Z/U move item
Modified press Enter
4_[
Figure 3.2-5¢ Figure 3.2-6¢

User can push “Z/U” Keys to move the green block on the intent parameter, then he could

change the parameter if needed. “OK” to validate the change, and “Esc” to invalidate the change.
3.3 Z/U Key

The Z/U key can be pressed when the system is idle or the work is finished. On pressing this

key, it will show some entries in the following interface:

[ Z move J [ Language+ ]
[ U move ] [ IP setup+ ]
[ Axis reset+ ] [ Diagnoses+ ]
[ Manual Set+ ] [Screen Qrigin+ ]

Laser Set+
Origin set+
Set Fact Para

Def Fact Para

Auto Focus

Figure 3.3-1+

Push “Y+/-" keys to move the green block to the anticipant item, and then push the “Enter”

key to display the sub menu.

18
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3.3.1 Z move

When the green block is on “Z Move” item, “X+/- keys can be used to move the z axes.

3.3.2 U move

When the green block is on “U Move” item, “X+/-" keys can be used to move the u axes.

3.3.3 Axis reset+

When the green block is on this item, push the “Enter” key to show as below:

XY axis reset

-

X axis reset

Y axis reset

[ Z axis reset

[ U axis reset

Figure 3.3-2¢

Push the “Y+/-“ Keys to move the cursor to one of the entry, then push “Enter” key to restart the

selected axis, the screen will show some information when resetting.

3.3.4 Manual set+

When the green block is on this item, push the “Enter” key to show as below:

Mode: [T continue

manual: mm

Press Z/U move item
Modified press Enter

Figure 3.3-3¢

Push “Z/U” key to move the green block, and when the green block is on the “Mode” item, push

“X+-“ keys to select the anticipant value, “Continue” or “Manual”. When “Continue” item is

19
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selected, then the “Manual” item is not valid, on that time, push the direction keys to move the
corresponding axes, and when the pushed key is loosed, then the corresponding axes will finish
moving. When the Mode item is “manual”, then pushing the direction key one time,
the corresponding axes will move a fixed length, unless the scope is overstepped.

3.3.5 Laser set+

When the green block is on this item, push the “Enter” key to show as below:

Mode:

Laser Set: 50 ms

Press Z/U move item

Modified press Enter

Figure3.3-4 ¢

Push “Z/U” key to move the green block, and when the green block is on the “Mode” item, push
“X+-“ keys to select the anticipant value, “Continue” or “Manual”. When “Continue”  item is
selected, then the “Laser Set” item is not valid, on that time, push the Laser key to splash the
enabled lasers, and when Laser key is loosed, then the lasers will finish splashing. When the Mode

item is “manual”, then pushing the Laser key one time, the enabled lasers will splash a fixed time.
3.3.6 Origin set+

When the green block is on this item, push the “Enter” key to show as below:

[ Muti origin enable |
[_] Origin enable1l [ ] Origin enable3
[ ] Origin enable2 [ ] Origin enable4

Set origin: <>
Next origin: <)

Press Z/U move item

Modified press Enter

Figure 3.3-5¢
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Push “Z/U” key to move the green block to the anticipant item, and when the green block is on

“enable” items, push “Enter” key to enable or disable the item, when enabled, the small diamonds is

green, and when disabled, the small diamonds is grey. When the green block is on the “Set origin”

item or the “Next origin” item, push the “X+-* keys to select the value.

Pay attention to if when the green block is on the “Set origin” item, push the “X+-* keys to

select a value, then, “Enter” key must be pushed to valid the change, or, the change is invalid.

Each item introduced as below:

>

Multiple Origins Enable: “Yes” or “No” can be selected. If you select “No”, the system will
use the single-origin logic. You can press the “Origin” key and set the origin, and only this
origin can become valid. If you select “Yes”, the system will use the multiple- origin logic
and the “Origin” key on the keyboard become invalid. In such a case, the parameter of each

origin must be set in the menu as follows.

Origin Enablel/2/3/4: after the multiple-origin logic is enabled, the four origins can
independently be prohibited and enabled.

Set Origin 1/2/3/4: after the multiple- origin logic is enabled, you can stop the cursor at “Set
as Origin 1/2/3/4”. Press the “Enter” key on the keyboard and the system will take the

coordinate figures of current X/Y axles as the corresponding ones to the origin 1/2/3/4.

» Next Origin: there are such five digits as 0~4 for option, which are the origins to be used for

the next figure. Origin 0 means the origin set by the “Origin” key on the panel in the single-
origin logic. 1~4 means the serial number of the origins in the multiple- origin logic. Next
origin can be modified to any one of origin 1~4, so as to control the start location of next

work (the premise is that the origin is enabled), but it can’t be modified to origin 0.

Once the multiple- origin logic is selected and if the serial
w= | number of the next origin is 1 and four origins are enabled, when

Prompt

the memory file function is started or the processing file is

uploaded into the PC and this file selects “Take the Original

Origin as current Origin”, the work started for each time will use

different  origins. The rotation order of origin is

1->2->3->4->1->2.......
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3.3.7 Set Fact Para

After the “Set Fact Para” is selected and the Enter key pressed, the interface will show the

specific password to be entered when set as default parameter.

Password: | 123456

Password error

01234567809
ABCDEFGHIJ
KLMNOPQRST
UVWXYZ

Figure 8.3-6+¢

Push “X+/-" keys and “Y+/-" keys to select the characters, and push the “Enter” key to valid the
characters, when finishing enter the password ,that is to say, the six characters, if the password is

error, it prompts there is some error, or, all parameters are stored.

After the manufacturer regulates all parameters of the
w= | machine well (including all manufacturer parameters and

Prompt

user parameters), this function can be used to store the

well-regulated parameters to help users to recover the

original parameters (including all manufacturer parameters

and user parameters) through selecting “Recover Para”

when they regulate parameters improperly.

3.3.8 Def Fact Para

After the “Def Fact Para” is selected and the Enter key pressed, the “Successful Recovery”

dialog box will pop up to prompt that all manufacturer parameters and user parameters are recovered

successfully. You can return to the previous menu by press the Enter key.
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3.3.9 Auto Focus ( Laser machine with Optional function)

When the cursor stops at “Auto Focus”, press the Enter key to search for the focus(When there is

z axes, and the z axes reset function is enabled, the auto focusing is valid); press the Esc key to return

the prior menu.

3.3.10 Language

The item “Language” helps you to select a appropriate language which is displayed on the pane:

Simplify

Tradition

English

Figure 8.3-7

3.11 IP Setup

When the green block is on this item, push the “Enter” key to show as below:

IP address:

192] [168] [ 1 ][ 100

Gateway:

202 | [ 96 | [134] [ 133

Press Z/U move item
Modified press Enter

Figure 3.3-8

Push “Z/U” key to move the changing item, then push “X+/-” keys and “Y+/-" keys to change
the value, when all the IP value and the Gateway value are changed, push “Enter” key to validate the

change, or “Esc” key to invalidate the change.
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3.12 Diagnoses

If the “Diagnoses” item is pressed, the system will show as below:

[] X Limit+ [m] X Limit -
[m] Y Limit+ [C]Y Limit-
[]Z Limit+ [(] Z Limit-
[JU Limit+ [(] U Limit-
[ ] water prot1
[ ] water prot2

[ ] Open prot

Figure 3.3-9¢

This interface shows some system input information, such as limiter status, the status of the
water protecting, and the status of the foot switch etc.. When the input is validated, the color frame

will be green, otherwise it’s gray.
3.13 Screen Origin

If the “Screen Origin” item is pressed, the system will show as below:

Origin locat:

To modify press€& /2>
Modified press Enter

Figure 3.3-10+¢

There are four entries to be selected: Top Left, Top Right, Bottom Left and Bottom Right. When
one is selected, the previewed graph on the screen would be enantiomorphous based on X or Y
direction.

This item is only used to preview the file on the screen, and it is

3
Caution

no meaning to the machine’s movement.
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3.4 File Key

3.4.1 Memory File

On the main interface, if “File” key is pressed, it will show as below:

File: Count: [ Read mem file )| File: 01
: | Speed: 300mm/s
L gy | S ;z;:w, | 30.0%/30{0%
03 100 [ Other+ ] = [ 1502 o
[ Run ] Yz T mm
( Track )| 2z | 3000 |mm
[  Work time | s
[ Clear count | ."/ \'I
( Delete | \ /
( Copy to udisk | S
Idle 00.00.00 Count: 99 X: 180.5 mmY: 235.6 mm connect

When showing this menu, the system would read the memory file firstly, the file name and the work
times would be listed in the area, and the selected file is previewed in the bottom right area. “Y+/-”
keys could be used to move the cursor on the file name list.

name, presses the “Enter” key, the selected file will be previewed on the main interface, and then if

Figure 3.4-1«

“Esc” key is pushed, the preview will disappear.

“X+/-" keys could be used to move the cursor left and right. All the item show as below:

Read mem file: read the memory file list;

Udisk: read the U disk file list;

Other: the other operation of the memory files;

Run: To run the selected file;

Track: To track the selected file, and the track mode is optional;

Work time: To forecast the running time of the selected file, and the time is accurate to 1ms;
Clear count: To clear the running times of the selected file;

Delete: To delete the selected file in the memory;

Copy to Udisk: To copy the selected file to Udisk;

If the “Other” entry is pressed, the system will show as below:
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[ Current work time |

[ Clear all count |

[ deleteallfile |

([ Format speedly |

[ Format drastically |

Total: 10 Clear

Figure 3.4-2¢

® Current work time: To forecast the running time of the current file(the current file No. is
showed on the main interface), and the time is accurate to Ims.
® (Clear all count: To clear the running times of every file in the memory
® Delete all file: To delete all memory files
® Format speedily: To format memory speedily, and then all the files in memory will be deleted.
® Format drastically: To format memory drastically, and then all the files in memory will be deleted.
® Total: the total running times of all the files.
3.4.2 U Disk File

If the “Udisk” entry in figure 3.4-1 is pressed, the system will show as figure 3.4-3, and the
operation method is all the same as figure 3.4-1.

File:

e .
02
03 [ Copy to memery |

( Delete |

Figure 3.4-3¢

® Read Udisk: read the file list in the Udisk;
® Copy to memory: copy the target Udisk file to the memory;
® Delete: delete the selected Udisk file;
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This system supports such file formats of Udisk as FAT32 and FAT16,
o= but it can identify them when the files are put under the root directory
Prompt of Udisk. The file name of more than 8 characters will automatically be
cut out by the system. The file name that has only English letters and
digits will not show when they are copied to the mainboard. The files
copied from the mainboard to Udisk will be placed under the root

directory of Udisk.

3.5 Introduction to some alarm info

When users are operating the system, or when the machine is running, some alarm information
such as water protecting error maybe shows as below:

Water error

Esc Enter

Figure 3.5-1¢

Push “Enter” key or “Esc” key, the system will execute some relative steps.

3.6Interface

Udisk Interface: Udisk is a USB-AM interface.
The controller may visit the u-disk by this interface.«

PC-USB Interface: PC-USB is a USB-BM interface. «

The controller may communicate with PC by this port.
Pl

Ethernet Interface: Using this interface, the mainboard
can communicate with PC by 10/100MHZ Ethernet.«

&

otorized up and down worktable Switch.
is optional.
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| Chapter 4 Alignment Standards of Optical Path

During common use, there may appear some deviation with the optical path, resulting in no
laser or light path is abnormal, then please refer to the following method to adjust the optical path:

Step 1: First to ensure laser beam from laser tube to the center of 1# reflector mirror.

Step 2: Affix multi-storey double sticky tape paper on the 2# reflector (Or other objects can be
marked on), move laser beam to closest location of laser tube, press pulse(choose suitable power),get
a spot on the paper(with special attention: In order to prevent the laser radiation wounding, with a
piece of cardboard first to test the approximate location of the spot, and then adjust).

1#
laser tube [::]

Uy, 32

A%

Step 3: Move away the beam to the position far from the laser tube, press pulse, get another spot

1#
;&:j laser tube E:]

on the paper.

|
Wy, 3#
>
24

4#
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Step 4: If the two spots are not superposition, adjust the screws on the back of the 1#mirror to
make the laser fire on the same position as the first spot.

Step 5: Repeat the second to the fourth steps until the two spots overlap completely. Moreover,
the spots should be in the center of the hole.

Step 6: Affix multi-storey double sticky tape paper on the 3# reflector ,move laser head to the
nearest position from 2# mirror, press pulse(choose suitable power),get a spot on the paper.

lgeﬂ laser tube [:]

L 2

||||
3#
2#
4#

Step 7: Move away the laser head to the position farthest from the 2# mirror, press pulse(first to detect

the approximate location of laser with a piece of cardboard to prevent wounding),get another spot .

1# SN
;(—Eﬁ laser tube [:]

Y

||Il
3H
2#

4#

A 4
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Step 8: If the two spots are not superposition, adjust the screws on the back of the 2# mirror to
make the laser fire on the same position as the first spot.

Step 9: Repeat the sixth to eighth steps until the two spots overlap completely. Moreover, the
spots should be in the center of the hole.

Step 10: Affix multi-storey double sticky tape paper on the 3# reflector, press pulse, get a spot
on the paper. If it is in the center of light hole, then pass.

Step 11: If the laser light is not in the center of light hole, as below figure:
In the left Figure, the spot is upper and right biased.
Top to bottom bias: can only raise or lower the laser tube.
Inside and outside bias: only move the laser tube in or out to adjust.

In this case, it is essential to lower the laser tube(here refers to low-voltage side of the laser

tube),and then, from the beginning of all the re-adjustment of the first step.

Note: The operator can’t do the above working until after the professional
training. Otherwise, the operator do this working must with the help of the
professional .The operator must pay attention to security when adjusting, to
prevent the laser radiation wounding.
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| Chapter 5 Daily Maintenance and Common Faults

The stable working of the machine is inseparable with normal daily operation and maintenance.
Here are some common daily maintenance and common faults analysis:

5.1 Daily maintenance

1. Replacement of the cooling water (clean water tank and replace recycled water once a week

are recommended):

Quality and temperature of the cooling water can affect the lifetime of laser tube directly,
suggest use purified water or distilled water, and water temperature should be below than
35 ‘C.When higher than 35 °C,please replace cooling water, or add ice cubes to lower the water

temperature,(cooling device is recommended, or use two water tanks).
Note: To ensure that the laser tube full filled with cooling water before machine working.
2. Cleaning of Water Tank

First of all, turn off power, disconnect the water inlet pipe, let the inside water of the laser tube
flow into the water tank automatically, open water tank, take out the water pump, clean water pump
and water tank, put the pump back to water tank, insert the water pipe which connect water pump to
water inlet mouth of the machine, finish all joints, then replace cooling water. Turn on the water

pump power supply is lately, let the pump run 2-3 minutes (make laser tube full filled with water).
3. Cleaning of Exhaust Fan

After long time using, inside of fan will accumulate much solid dust, so the exhaust fan will
make a great noise, and it is not conducive to the exhaust .When the exhaust effect become poor, we
have to clean the fan and smoke pipe .Firstly, turn off the power supply, remove the two pipes from

the fan, clean dust inside of the pipes, and then clean the dust inside of the fan.

4. Cleaning of Lens (daily cleaning is recommended before work, equipment must be in

shutdown state)

As we have talked before, engraving machine has three reflector mirrors and one focus lens (1#
reflector mirror is near the light outlet mouth of laser tube, the upper left corner of the machine, 2#
reflector mirror is at left side of the beam, 3# reflector mirror is on the top of laser head, the focus
lens is located in the bottom part of the laser head), the laser is send out by the mirror reflecting and
focus lens focalizing. Mirror is easy to be dirty, resulting in laser loss and mirror damage, you
needn’t remove 1#,2# and 3# mirror when cleaning them, Just using a cotton bar to dip some

cleaning solution (acetone or alcohol) , swab carefully by rotating from central to edge of the lens.

Take out the focus lens from the laser head, using the same method clean it, after cleaning, put it

back.
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Note: @O you should wipe the lens carefully, can not damage the surface coating;
2 you should do that lightly, to prevent falling; ®keep concave side downward
when install the focus lens.

5. Cleaning of Guideway (suggest cleaning every two weeks, equipment must be
in shutdown state)

First of all, move the laser head to the far right (or left),wipe with a dry cloth until shiny clean,
together with a little oil (sewing machine oil is recommended),push the laser head several times
slowly along the guide, so that lubricant can be evenly distributed. Clean and lubricate the Y axis two

guideways is the same as X axis.

Note: Please prepare for cleaning Guide - dry cotton cloth, lubricating oil.

6. Optical path inspection

Optical path system of the laser engraving machine is completed by the mirror reflection and
focus lens focusing, and there is optical path bias with the focus lens, but the three mirrors is fixed by
the mechanical part, optical path bias is very possible for them ,although there is no optical bias

normally, we still suggest you check optical path before working.

Please get detailed explanation from I Chapter 4 "Alignment Standards of Optical Path "
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5.2 Common Faults Analysis

N | Phenomena of . .
‘ Analysis method Solution
0. Malfunction
Check power supply of machine | Make all power supply -electrify
. connects well or not again
. Open the machine
but no movement | Mainboard parameter is right or | Correct the parameters according
not to software operating manual
) ) ) o Correct the laser parameters
Working with | Mainboard parameter is right or ] ]
2 according to software operating
nonstop laser not
manual
Check  water circulation is | Clean water tank, water pump and
Desultory light o .
3 swimmingly or not water pipe
when working
Voltage is stable or not Add regulator for the laser machine
Correct the X and Y axis
A Self-test abnormal | Mainboard parameter is right or | direction ,limit position parameters
when starting not according to software operating
manual
Check whether the data port
o Choose correct port
choice is correct.
After output Check whether turn on the .
‘ Turn on the machine
5 | data ,machine no machine
action Check whether connected ground ‘
. . Connect ground wire
wire for the machine
check whether installed the USB driver | install the USB driver
Check whether optical path is bias | Adjust the optical path
No laser when
6 working Check whether the cooling water ‘ ‘
) ) Ensure the water is running
is running
Can’t detect the The computer or USB )
7 Change computer or USB line

laser equipment

communication problem
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| Chapter 6 Warranty Regulations

I 6.1 Warranty Periods

From the date of purchase, the machine has 1 year warranty (except
consumables). Optical lenses and the laser tube are consumables, three months

warranty.

I 6.2 Warranty Clauses

This warranty is for products of our company.

During the warranty period and under the correct use, malfunction can be based
on this warranty terms, show the warranty card or invoice, enjoy our free maintenance

service.

The following cases, can’t enjoy the free service, a fee will be charged according

to the concrete condition.
1) Maintenance services not caused by the machine quality;
2) Overstep the warranty period;
3) Can’t show or alter warranty card;
4) Didn’t fulfill the contractual obligation;

5) Without the company agrees, privately to tear open outfit, modification,

maintenance of product;
6) Equipment failure due to human or force majeure factors.

The company only assume the legal obligation for the product itself, but don't
assume other responsibilities which caused by the using of the products.
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II RDCAM V8.0 Software Manual

IT Chapter 1 Overview

1.1 Laser engraving cutting system introduction

Laser engraving cutting system through a computer numerical control machine
tools to achieve effective control, according to the user’s different requirements of the

completion of processing tasks.

The system including control board and control panel, and supporting software.
This manual describes how to use the software to complete the task of laser
processing.( Motherboard wiring and control panel operations, Motherboard wiring

and control panel operations, you can contact with us when you need it)
1.2 Software supported file formats

Vector format: dxf, ai, plt, dst, dsb...etc.
Bitmap format: bmp,jpg,gif,png,mng...etc.
1.3 Environmental requirements
(1) Windows XP operating system and above, XP recommended.
(2) CPU 586 above, it is recommended that the P III or P IV above

(3) It is recommended to use more than 1G of memory.
1.4 RDPlug Plug-ins Software ManualV8.0

Embedded software can be embedded in CorelDraw. AutoCAD. CaDian2010 and

[lustrator CS5 software, the software is similar to the operation, embedded software,
installation methods, please refer to the electronic manual << RDPlug Plug-ins

Software Manual V8.0 >>.
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Il Chapter 2 Software installation

2.1 Install steps

o]

RDWorksV8
Setupd
(1) Double-click the under the installation directory, the following dialog box

appears:

of RDWorks8. 01. 05 Install

Welcome to the RDWorks Setup Wizard

This wizard will quide you through the installation of RDWorks.

Itis recommended that you close all other applications before starting Setup. This
will make it possible to update relevant system files without having to reboot your
computer.

Click Next to continue.

Instal | | cancel ]

(2) Click [Install Driver] to install USB drive:
Click install, then appears:

If there are hardware installation prompts, choose continue until the installation is

=

complete.

IInstall USE driverl Unistall USB l

Language: | EEVERTNMMNNNN v |

Type: iLaser\’l‘ork v ’

DLocate install path

Flugz RDforks

Install [ Exit ]
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Hardware Installation

! E The software you are installing for this hardware:
L
USB Serial Converter

has not passed Windows Logo testing to verify its compatibility

with Windows XP. [Tell me why this testing is important. )

Continuing your installation of this software may impair
or destabilize the correct operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

| Continue Anyway | {_STOP Installation |

After installation, the following dialog box appears, indicating the successful installation

of USB drivers.
RDWorksSetUpV8 [X]

! l,) Install Failure!

(3) Select the software version of the type and language, as shown below:

d

Install USE driver Unistall USB

Language: M | Select install language«

Type: i.aser'ﬂ'oric v \

[[JLocate install path

Install Exit

(4) Click [Install] .After installation, following dialog box appears, indicating the software
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has been installed successfully.

RLaserSetUp @

L]
1) Install Finish!

EDWorksVE

this picture will appears on your computer desktop.

Il Chapter 3 Software Basic Operation

3.1 The main interface operation

After start the software, you can see the interface shown in the following figure.

Menu bar+ | = Graphics bar-|| System bar« |[= Align bar-

Defaunlt -

Fle)  EHME)  OuwlD) Coofolf) Hnde(W) Vew() Heb(H)
D #3ea CRAQAARQA O /oA MBMAE] B 5% RAX®E xY1aslB RAMKE

Y - - /@ O .
&% o PP, I T TN TS T T I T T AT . T . P X
i = Work  Outpt | Doc User | Test | Trandorm
‘ =|: Layer Mode Speed Power Output
7 )
/ E .
~r1 P Edit bare
0O »
s
o & = Control panel- <
A -
of |3
o i e
m | Uricokaen set
': N space(men) Dislocarion(mm)
x E_ Xl 0 0 E
Py - 0 0 Bostrew...
€4 |-
B B
5
! Lasar work
§: . [ sat [ pumeicoern [ 200 |
a Layer bar« (Sarotoirie ) [ Uroust ) cowiond |
' A [Z]Path optimze e
%= [ Output select raphics Cut scae
- Device
-: [ Ustiuko
i_]. Postion: Current poskx ¥
* AHENT EEEEEE HE W
BITNS s RRE T LRSS 12T EREANI AR RTANE X: 329, MSes, 1177, MTne o

Menu Bar: The main function of this software are available through the implementation of the Menu
Bar. Execute the menu command is the most basic mode of operation. Menu Bar including:

Document. Edit. Draw. Setting. Processing. View and Help.

System Bar: On the System Bar, placed some most commonly command buttons which is chosen

from the menu.
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Graphics Bar: Graphics property bar is the basic attributes of graphics operations, including graphic

location, size, scale, number processing.

Edit Bar: The Edit Bar default on the left of the work area. In the Edit Bar placed frequently used

tools to make the operation more flexible and convenient.
Align Bar: Alignment of the selected objects.
Layer Bar: Change the layer of the selected objects.

Control Panel : Using the Control Panel to complete laser processing of multiple tasks, Layer

parameter settings, axis control, processing ...etc.
3.2 Language settings and machine information

In addition to installation process can set the software language type, you can easily switch in

different language.

Click Menu Bar [ Help ] -> [ &5 /Language ] expand menu, select the required language types.

Help (H)
About RDCAM o4
| &5 /Language P
EoPX
English |

Other

To obtain manufacturers information, so that we can provide you with better service. Click Menu

Bar [Help] -> [ About RDCAM]

|
Corp. Name: l

Tel:

[
Addr:|

|
|
|
|
|

Web:

v8.01.05 Exit

39



User’s Manual of Laser Engraving / Cutting machine

3.3 page setting

Click Menu Bar [Config] -> [Page setting] the following dialog box appears:

Page setting @

Page size
Page width: l1200] mm
Page height: 800 mm
Grid
GridSpace: 'S0 mm
Keyboard
Adust distance: |1 | mm

Adjust ratio: |10

Adust angle: |

Color config

Background:
Grid: |

[ Ok ] [ Cancel ]

[ Page width]: Software page width, usually associated with machine X breadth.
[ Page height]: Software page height, usually associated with machine Y breadth.

Under normal circumstances, if you have connected to the motherboard, software will

automatically format for the current work of the machine, as a page size.

If the board is not connected, or need their own custom page size (such as to set the page size by

material), you can use the page setting to reconfigure the page size.
[Grid]
Setting gird space and whether enable grid.
[ Keyboard]
User can use arrow key to moving or rotating the selected graphics.
[ Color config]

Setting the color of the work area.
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3.4 File open and save

The software uses rld file format to save graphic information. layer parameters of various layers and
processing sequence of the graphic elements.

3.4.1 Open File
(1) Click menu [File] -> [Open] ,or click iconi@, the following dialog box appears:

Open... @

Look in: | [Z Desktop v‘ O3 e @

iD My Documents
} My Computer

‘Q My Network Places

[C)RDCAMSetUp ¥3.0.2

() SendCommand

ettt

Select file

File name: ’Detault.rld l I Open ]

Files of type: "‘.rld v] [ Cancel ]

[] Open as read-only

(2) Select file (e.g. Default.rld), click [Open]
3.4.2 Save File

(1) Click menu [File] -> [Save] ,or click iconld the following dialog box appears:

Open... @@

Look i | (2 Desktop %O B

LMy Documents
i My Computer
Sy Network Places
(RDCAMSetUp ¥3.0.2 Input file name+
L SendCommand
COtte

File name: Defaut.rd
Files of type: | "id v
["] Open as read-only b

(2) Enter the file name in the edit box, then click [Save] .

3.5 File import and export
Supported file format for import: dxf, ai, plt, dst, dsb...etc
Supported file format for export plt
3.5.1 File import

Click menu [File] -> [Tmport] , or click icon & . The following dialog box appears.
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Select file, and click [Open] .

Look jn: & PLT v O 2 =@
0000033, plt HE#R. plt IR 8. ol
=957, plt T4 plt IE & plt
= 7000.plt IR BETEF 1Lk U= BT plt
= 9576 plt o e it O 4 it
= 0s0721.plt =% plt
& a7.plt R eSS i
O 2. plt
& Alphabet. plt O EER it
= 0P pit o =, ple
@Beach.plt @&'Eﬁﬁm.plt
@Box and Curve.plt ORI plt
@Box.plt @EI%I .ple
@Business.plt @ Elf22323.plt
@Circle.plt @ﬁﬂﬂ-zplt
B CONGER. plt O 588, plt
@Curve.p[t @iﬁ?ﬁﬁﬁ‘g‘.plt
| ) defautt.rd CE AL plt
& gernm. plt I 2 plt
T job 2.plt O N R plt
@shoelz.p[t @'Iﬂ‘g.plt
GE#R2.plt O 5 Ik i it

Preview

File name: Airplane.plt
Files of type: Supported Files1 v

Select [Preview] , the selected file can be shown.

For most vector file, data automatically imported into the corresponding layer of RDCAM software according to
the layer description.

For some special documents such as DST/DSB, data will be imported into the current layer.

Import @@

Look in: | & DsT v/ (€] ¥ B

= L5045-.05T

= L5086.05T

B Lx215.057

= miso.osT

= PorsCcHEZ.DST
=) sunFLOWR DT
=) veronIka.DST

Preview
File hame: Ahudiel DST
Files of type: Supported Files1 v|
4__I
, Current layer+
& J
o
+l

HE U N EETE .

42



User’s Manual of Laser Engraving / Cutting machine

3.5.2 File export

Click menu [File] -> [Export] or click icon CH . The Export dialog box appears.
Input file name, and click button [Save] .

3.5.3 File parameters setting

File Parameter @

Import Setting
PLT Precision: 1016 v
DXF Unit: MM v

[]tmport Dxf text info

[[]smooth curves

Auto close curves B
Close ervor{mm): 0.1

Combine lines

Combine error{mm): 0.1

Export Setting:
Export Precision{%); |80

Yelocity Unit: | mm/fs v

[ Ok } [ Cancel ]

PLT Precision: According to the accuracy of the original plt file to select the appropriate import unit.

Smooth curves: When import vector file, automatically smoothing the original curves. For the
original graphic is smooth or need to repeatedly adjust the beset smoothing effect, you can uncheck

this button. Do not do smoothing curves may reduce time of import processing.
Auto close curves: According to close tolerance automatic check and closed curve
Combine lines: According to merger tolerance, auto-connecting curves.

Color map automatically switch to gray scale: Because under normal circumstances, graphics are

based on gray scale. If the imported bitmap is a color image can be converted to grayscale.

Import Dxf text message: When the user need only Dxf the graphic information, not need the text

information within the file, do not check this.
Export precision: The precision of export plt file or output file.

Velocity unit: Software supported two types of speed unit: mm/s. m/min. Selected according to

usage. After it was selected, the speed of parameters on the interface unit will change with it.
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3.5.4 Image Library

For some frequently used graphics to be stored in the gallery is commonly used in the ease of use

Image library l_ijyélﬂ[j_&]
Lib name Preview Image number: 1
wew |
wewrife
New lib ” Del lib Add Image Del Image
Exopt options
(V] Original size 60.000 60.000
Lock scale

3.6 Basic graphics creation

€ Line

Click menu [Draw] -> [Line] , or click Edit Bar 7 ,drag the mouse on the screen you can
draw an arbitrary line. Press the “Ctrl” key while dragging the mouse to draw horizontal or vertical line.

€ Poly line

Click menu [Draw] -> [ Poly line], or click Edit Bar - - Drag the mouse on the screen you

can draw an arbitrary poly line.

€ Rectangle

Click menu [ Draw] -> [ Rectangle] , or click Edit Bar O Drag the mouse on the screen you
can draw an arbitrary size rectangle.

Press the “Ctrl” key while dragging the mouse to draw square.

@ Ellipse

Click menu [Draw] -> [Ellipse], or click Edit Bar = § Drag the mouse on the screen
you can draw an arbitrary size ellipse.

Press the “Ctrl” key while dragging the mouse to draw round.

& Point

Click menu [Draw] -> [Ellipse ], or click Edit Bar * . Click the mouse on the screen, you can draw
a point.
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@ Text

Click menul Draw ]->[ Text], or click Edit Bar A . And then in a drawing area any position click,
pop-up text input dialog box.

() TrueType font: ' B Tahoma v wWidth: |50 %
O stix font: & Fs.SHX Char space: ’0 | mm
Text Line space: !'U mm
[T]Enable variable text
Height: 2100 | mm [ OK ] [ Cancel ]

Choose font word, input text word, then set height, width, char space, line space. Click [OK] .

The software also supports variable text, the so-called variable text; the text is need according to
certain rules change, every output processing time, text to be automatic change again. For the system

variables have character type date variables and serial number.

(@ TrueType font: ['11‘ Tahoma V; Width: |50 ; o
(O SHX font: 5y Fs.shy e ‘0 L
mfexi‘t = Line space: ibﬁ mm
Enable variable text
T —

| 12Hour[HH:MM][09:09]

| 12Hour[HH:MM][09:09:21]

| 24Hour[HH:MM][09:09]

| 24Hour[HH:MM][09:09:21]

| American Date[02/07/2012]

| Chinese Date[20125F02 §07H]

| Chinese Date Time[2012802 07

| Chinese Time[09BF094321%5]
|European Date Time[07/02/2012a]
|European Date[07.02.2012]

}Weef Year[ﬂ?!}]Z!gUlZ 99:09:21] v

Offset: Day ‘:‘0 -
Height: :V100 lmm [ Apply ] [ OK ] [ Cancel ]

Variable is the date when the current every time processing take the current system of computer

time output. Software offers a variety of date format for customers to choose.
Users can also set the date migration; have the day by the month according to the years 3 kinds.

As in packaging carved on the expiration period can use the product.
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Text
®TrUEType " e 3 o i
. xten @
Ostix font: i Fs.shx Char space: |0 | mm
| Text Li o [ S, P i
e - Enablereset; 9999
Enable variable text - 3
: ‘ v |Enable prefix ZERO
focraiot i L3 :
Prefix: |
S [T]Enable SN array
Suffix: |
Start Shi; 0000 MNumber Space ||||||
Current SN: (0000 y [ 1T =
SN Inc: |1 s R
v =
Ei i [ OK ] [ Cancel ]
Height: 100 mm [ Apply ] [ OK ] [ Cancel ]

It ABCOOO1DEF processes repeatedly, ABCO002DEF, ABCOO3DEF until ABC9999DEF a

group of serial number.

[Prefix] : Serial number prefix, example ABC is leading string.

[Suffix] : The serial number of the suffix, example DEF is the string after.

[ Start SN] : From which a specified number start manufacturing, example is to start to 0001 serial number.

[ Current SN]

current to processing which serial number. As in the processing a group of serial number, leakage

: The current processing to which, serial Numbers, can also be used to specify the

processing the one, but through the designated the current serial number to make processing, not set
start, serial Numbers, because in some cases a group of serial number requires repeated processing,

namely to a serial number, need to go back to the start serial number start manufacturing.

[ SN Inc]

processing from 0001 to 9999 serial number, the increment is 1.

: the interval number can be prescribed sequence number. Example will in turn

If only need to output even or odd number serial number, can set incremental is 2.

[ Enable reset] : when serial number processing to reset the serial number,

[current SN]  will be automatically reset to [start SN .

Example requires repeated processing from 0001 to 9999, serial Numbers, so can be designated
9999 as reset, serial Numbers, when processing the 9999 serial number, text will automatically
change to 0001.

[ Enable prefix ZERO]
serial number of zero digital before the zero. Such as the example, serial Numbers, if not the leader's
zero can ABCOOO1DEF will become ABC1DEF. But it is worth noting that, if we want to output
serial number is ABC1DEF, ABC2DEF until ABC9999DEF, we can't through the will

: if not lead to zero, the system will automatically remove the first in the

[start SN] set to 1 to achieve, but through the cancel [ Enable prefix ZERO] to achieve, this is

because set in the specified number from the start the serial number which one, beginning outside,
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also specifies the number of significant digits, such as will begin to serial number set to 1, the change
of the serial number order is: 1,2,3,4,5,6,7,8,9,0,1,2,3,4,5... Serial number won't change to 10,

because the effective a serial number had 1.
[ Enable SN array ] to the array of way, one-time processing more serial number.

for instance:

0001 0002 0003 after this batch processing serial number, 00150014 0013

0006 0005 0004 skip directly to the next group of 0007 0008 0009
0016 0017 0018 0016 0017 0018
& Capture

Click menu [Draw] -> [Capture]

HedE ki

BiH

If the computer has been connected to the image device, the dialog box will appear. After it was

selected, you can collect the pictures from the specified device.

3.7 Object selection

In the process of drawing and edit graphics, first of all is to select the object.

2

When the object is being selected, in the center of this object will have a shaped mark™ x , and

surrounded by eight control points.

Click menul Draw J->[ Select ], or click Edit Bar Xy , switch to status “Select”. Under this status,

you can select object. The following are five kinds of method of selecting:
€ Click menu [Edit] -> [Select All] (Shortcuts Ctrl+A) , select all objects.

€ Click mouse on the screen to select single object
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@ Sclect object using select box

Press the mouse and drag, as long as the box come into contact with the object will be selected.
@ Increased select object/minus select object

Increase select: Press “Shift” key, click or box select to increase select object.

Minus select: Press “Shift” key, click or box selects the selected object.

@ Seclect object according to layer

Layer Parameter

Layer Mode  Speed  Fower Output ‘

Cut  100.000 30.000 Yes
Cut 100.000 30.000 Yes
Cut 100.000 30.000 Yes
Cut 100.000 30.000 Yes
Cut 100.000 30.000 Yes

[~

Up Down

Right-click the selected layer, then the part of all objects in the layer will be selected.
3.8 Object color
The color of object that is the color of the object contour. You can click the color button on the

Layer Bar to change the color of the object has been selected. The color of the pressed button is the

color of current layer.

3.9 Object transformation

Transformation of object mainly include: object location, orientation and size, but does not

change the basic shape of the object and its characteristics.

Transformation of object for users, provides a convenient user interface. User can mirror
<1 0o

b
and rotation through b < B8 X OJ ithin the draw toolbar.

You can also use the Object Properties toolbar
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¥ |445.91 |mm #[235.989 | mm | 1100 | ez, 1 o
] ] 0 Process NO: |1
¥ 299,208 'mm § 208.549 | mm | (100 | %, n EE G
You can also use the right transformation tools to transform and copy the graphics.

| Work | Output | Doc | User | Test Transform

[+ o] €| 5| 2

Position:
H: mm
Vi mm

3.9.1 Object Image

Object image is flip the selected object in the horizontal or vertical direction.
Click Edit Bar Ak , flip the selected object horizontal.
Click Edit Bar 5 , flip the selected object vertical.

| Work | Output | Doc || User | Test | Transform

B

Ratio:
H: | %

V: 100 %,
Mirrar:

[] Disproportionate
|

o © O
Oo-0-3

[ Apply to copy ]

[ Apply J

Or through the mirror to the transformation tools, horizontal and vertical mirror, and copy.

3.9.2 Object Rotate
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The selected object, next, double-left click on

If you want to drag rotation, can move the mouse to | then press the left key

Dragging the mouse to adjust the rotate angle, in the dragging process, there will be followed by

..............................

rotating wire-frame outline. |
% 445.91 |mm *¥(235.989 | mm | (100 | o v o v

r ] ; ] r ] 0 Process NO: |1
Y |299.208 |\ mm § |208.549 | mm | 100 | %% n E O ‘ : ’
Or directly enter the rotation angle in the Object Properties toolbar.

| Work | Output | Doc | User | Test | Transform |

H[6] 2

Rotate:

H: |0

Center:

H: (44591 | mm
yv; [500.791 | mm

[JLock rotate center
[]Relative center

|||
o e O
Oo-0-d

[ Apply to copy |

[ Apply ]

Or use the spin rotation transformation tools to transform. In the rotations transformation tool can be

set to the center of rotation and locking center of rotation.

50



User’s Manual of Laser Engraving / Cutting machine

3.9.3 Object Size

% [445.91 |mm [ [235.989 | om | [100 | _| 0 .
Y [299.208|mm . [208.549] mm | [100 | % @HE C b 1° pecesnoli

You can set size and center position of the selected object.

'work | output | Doc | User || Test | Transform i

+ of &

Size:

H: 1235.989 mm
V: |208.549 mm

[F IR ]

o 0O

FI=F1=¥]
[ Apply to copy ]
I Apply |

Or use the size transformation toolbar to change the size of object. Can modify the size, choose

whether to lock the aspect ratio, and set the position relative to the object to transform.

3.9.4 Tilt

\work | Output | Doc | User | Test | Transform |

[]se anchor point:
[ Apply to copy ]
[ Apply |

51



User’s Manual of Laser Engraving / Cutting machine

Object can be tilted by the tilting transformation tools. It can be set the tilt anchor and the tilt angle.

The tilt will cause distortion of the bitmap and the practical application of small, currently only

supports the tilt vector graphics.
3.9.5 Object Array Replication

Click Edit Bar b3 » select object wants to copy. Then click oo , the following dialog box appears:

fArray copy ‘
XNum: 1 XSpace: 0.000
YNum: 1 YSpace: 0.000 Egg
[ Bestrew... ][ Ok H Cancel J
¥ Width of a single graphic(mm) I Height of a single graphic(mm)

You can array replication object along different directions. The direction of copy is based on the original
graphics. Such as choose the array direction lower right, then the original graphic will appear on the upper left

corner. If it is to the upper left array, then the original graph appears in the lower right.
After setting the array number and array spacing, click button [ Apply] ,you can see the actual graphics array.
There are two forms of array spacing: center spacing and edge spacing.

Choose center spacing, then [X Distance(mm)]. [Y Distance(mm)] representing the distance of the two

graphic center.

If not choose center spacing, then [X Distance(mm)]. [Y Distance(mm)] representing the distance of the

graphic edge.
Center distance X = Edge distance X + width of object
Center distance Y = Edge distance Y + height of object

Switch between the two kinds of calculate method, [ X Distance(mm)].['Y Distance(mm) Jwill be calculated

automatically.

Click [Bestrewing breadth], The software will automatically calculate the array number
according to the work piece size. width. height. X distance and Y distance.

Adjust spacing can be directly input values, and click [Apply]

Can also press the direction keys to adjust objects spacing.

Check [Center] ,then after object array replication, graphics will be centered on the work area.
Scroll the mouse wheel to zoom view of the graphics.

Drag the mouse to pan view of the graphics.
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3.9.6 Place Object To The Origin

Place the object is to facilitate the view or orientation. The following tools are provided by software:

1%

, selected object will be placed in the center of the page, that is the object center coincides

with the center of the page.

K AN

left, upper left corner of the object, upper right, lower right, lower left and upper left corner, top right,

, Selected object will be placed on the page left, upper right, lower right, lower

bottom right, bottom left corner of coincidence.

3.10 Object Align

R e | n& C3 M
Select objects, click tools on the Align Bar = = 00 o oy H B0 H .

Which include:

= | |
2 &5 0o Left alignment. Right alignment. Top alignment. Bottom alignment
g g g p alig g

oy £2 [0

Vertical center alignment. Horizontal center alignment. center alignment

H % Horizontal equidistance. Vertical equidistance

= 0 H Same width. Same height. Same size.
Benchmark object:

If you press “Shift” key and select object one by one, then the benchmark object is the last object.

If you select object by select box, then the benchmark object is the object which curve number in the

final.

3.11 Object View

+
@ Move: Click menu [Edit] -> [Move), orclick “.Then hold down the left mouse button

in the drawing area, and drag pan.

@ Zoom Out: Click menu[Edit]1->[ZoomOut], or click T Each click it, the drawing area
zoom out once. Move mouse to the drawing area and click, each click, mouse position as

center drawing area zoom out once.

@ Zoom In: Click menu [Edit] - [ZoomIn], orclick .Each clickit, the drawing area
zoom in once. Move mouse to the drawing area and click, each click, mouse position as

center drawing area zoom in once.

® View Select: Click menu [Edit] -> [ View Select], or click ™. Move the mouse to the
53



User’s Manual of Laser Engraving / Cutting machine

drawing area, hold down the left mouse button and drag, a dash border box will show in the
drawing area, release mouse button, then the region in the dash border box will display in the

drawing area with the largest proportion.

@ View Page Frame: Click menul Edit]->[ View Page Frame), or click "% .The page frame
will full display.

& View Data Frame: Click menu [Edit] -> [ View Data Frame), or click * The selected
objects will full display

3.12 Group and Un Group

Edit graphics, and sometimes need to be a part of the operation as a whole (such as multi-line

text for typesetting).

Method: Select the group of graphics, and then select the menu [Edit] / [Group) ( [Un
Group) ), or directly select the toolbar | =% “8 |,

3.13 Important Tool
Here are some frequently used tools. Using these important tools, can make the current
document in the graphics more orderly, and make the processing of output faster.
3.13.1 Manual sorting and the set of cutting point and the cutting direction

Software provides users a convenient tool for the manual sorting. Select [Edit] -> [ Set cutting
property ] . Cutting property dialog box will pop up. All with manual sorting, and cut points, cutting

the direction of the settings in this dialog box can be completed.

Set cutting property
e e e B e e e T TP PP L] [ ReOrder ] [ Reverse ] [ ReOrder ]
) e et NO  Name ] ;VNO Name
” 1 Element1 @ \
2 Element2 |
3 Element3
y 4 Element4
ke 5 Elements
K 6 Element6
K
A ‘
=
c<d |
[¥] showPath _ﬂ_l M
o =l
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Show path

First check the “show path”, it will display the current graphics cutting order and the cutting

direction.
Manual sort

Select M This button is used to switch the current status of the operation is to edit or view. Then

you can marquee or click the graphics in the graphics display area (or click one pixel or check many

lﬁj

processed as the first primitive. Primitives followed by repeated operations, to complete sequencing

pixels). After selecting the graphic, select , these graphics to be redirected to another list, to be

of all graphics.
Change the direction of graphic processing

Mouse select the graphic in the graphics display area or in the list. And then c:lickmJ :
Change the cutting point

Set cutting property
ReOrder ] [ Reverse J [ ReOrder J
] [
NO Name | NO Name
Element1 i %

Element2 ‘

Element3 [

Element4

Element5
Elements

‘
P
'}
Oy bW N e

e gy -, - S A L

v
A
kY3

™
A
A

[¥] showPath _HJ __ILJ

Select the graphics that should be changed the cutting point, it will show all the nodes in the current
graphics. Select the starting point, double-click the mouse, it will change the starting point of the
current graphics. After the completion of all changes, click L ®E | , the result of the changes can

be saved.

In addition to cutting property features, the software also offers some tools to change the cutting

order, cutting direction and cutting point.

Select [ in the toolbar, or click the menu command [Edit] -> [Show Path] .
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DEEHEF00acaaaqq(ole s ~wEaHHSH W %%
x[0.518 mm §f(0.435 mm| 100 | o | - e |
erll:«s; mml‘;lwxs: [ 100 ] % QIE Ol poesiofz BdWmw & 3”}{ teld ,r\_ 1Ml @ auto | fcutinfout] (_check | Lorew. ]|
L., 2500 o, 20000 0 15000 1000 0,59.H.ly‘o.o?..,‘l..oﬁsp.4..|‘A.l.m"‘ : =
k JL & | Work iOumutlDoc IUser lTest lTransform‘
ﬁ 3 Layer Mode Speed Power  Output
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®| ]
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E - [7] output select graphics
ooo O: Device
(S
13 &
; UsB:Auto J

17 ]
'HHEEE ENENEN 7 TEECR
Manual sort

Choose the primitive that should be changed the cutting order, then the cutting serial number of the

current primitive will display in the object properties bar.

XLL06 mm iy 0.443 mm) 100 %ﬂﬂ GU l:'ProctassNO:"‘! | B <:>1 U?S ﬂQ Ee $ H : =] II] E

Y 0.958 mm f 0.396 mm| 100 % | | e |
2,000 L5000 1000 " 0,500 ,0:000] |

.In|2759q e gy (e [ PR [

=N

A 4

._p-500,

__1.000,

. [1.500,

MALsXEE «xx0OYN\ v

ooo
oog
ooo

R.090,

Enter the serial number directly in the processing number, then press the keyboard “Enter” key,

or click the plot area, the cutting order will be changed.
Change the processing direction
Click [Edit] -> [Set cut direction] , to enter the edit mode of the cutting direction. Then you can

double-click on any position on the selected graphic.
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Change the cutting point

Click [Edit]->[Set cut point], to enter the edit mode of the cutting point. Then select the curve that
should be edited, you can double-click on the node that you want to set the cutting point to complete

the change of the cutting point.
3.13.2 Setting And Editing The Cut In/Cut Out Lines
Drawing or importing curves, the curve is default not have any cut in/cut out lines.

If want to add cut in/cut out lines, select the objects, then click [ Edit] -> [ Edit cut in property],
or click 2 .The following dialog box appears.

Cut in and out setting |l§.3!

Cutin
| |Enable
Length(mm): 3
Angle(degree): |45
Cut out
[ |Enable

Length(mm):

Angle(degree): | 45

[ Ok ][ Cancel }

To make cut in/cut out lines, first of all need to enable the cut-in/cut out function.

There are two types of the cut in/cut out lines: straight line and arc

Straight line cut in achieve through three ways:
Cut in with angle: cut in line and starting segment into a certain angle, counterclockwise angle is positive
Cut in at center, the starting point of the cut in line is at center.

Cut in from center, the direction of the cut in line is from center to starting point, and length is as setting.

Cut out line«

Cutinline¢ |g e

The arc length of cut in arc is as setting.

There are two types of cut in/cut out arc, as shown in the following figure
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Female Male

The processing of setting cut out lines is same as cut in lines.
3.13.3 Path Optimization
Path optimization is primarily to re-order the vector graphics.

Click menu [Handle] -> [Cut optimize], or click o ,the following dialog box is appears.

Cutting optimize handle @

[Jorder of layer

Inside to outside
{Single inner to outer v ‘
Block handle
Height: |59 | Dir: |Up to bott v
[]start point optimize

Auto determine start point and direction

[ Ok I [ Cancel ]

Click menul Edit]->[ Show Path], or click ‘g , can see the cutting path before and after processing.

Laser head

Before proceésing | After processing:

Graphics cutting path is always starting from the laser head.
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3.13.4 Curve Smooth

For some less accuracy curves, this function can make curves more smoothness, and processing

smoother.

Click menu [Handle] -> [ Curve Smooth], orclick ©, the following dialog box appears.

Curves smooth @

Smoothness 1 9% [Jpirect smooth

| I [ Apply ][FuIIFrame][ Ok ][ Cancel ]

Drag the smooth slider, and click button [ Apply], before smooth and after smooth curves will all

show in the dialog.

The black curves represent the original curves, and the red curves represent after smooth curves.

Curves smooth @

Smoothness 1 9% [CIpirect smooth

l l [ Apply ][FulIFrame][ Ok ” Cancel ]

You can view the graphics with drag mouse.
You can zoom in/zoom out the graphics with scroll wheel.
Click button [Full Frame], graphics will shown in the dialog box for largest.
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After get satisfied smoothing effect, click button [ Apply ], curves will processing smooth

according to smoothness settings.
Select “Direct smooth” , you can use another smoothing method.
The choice of smoothing method should be changed with the needs of the actual graphic.

3.13.5 Check Closure

Click menul Handle J->[ Curve auto close ], or click System Bar [ ,the following dialog box appears

Setting close error @

Close error (wm): THEY

Force to close

Ok Cancel

Close error: When distance from the starting point to ending point less than close tolerance,

automatic closing of the curve.
Force to close: Mandatory closure of all selected curves.

3.13.6 Remove the Overlap

Click menu [Handle] -> [Delete overlap] ,or click Bl the dialog box appear.

Delete overlap lines @

[JEnable Overlap error

Overlap error{mm): ‘ |

[ ok | [ Cancel ]

Under normal circumstances do not select the “Enable Overlap error”. Removing the overlapping
lines when two lines are compared to a good degree of coincidence. If you need to delete overlapping
lines, you should select “Enable Overlap error”, and set overlap error. Generally do not overlap error

set too large, so as to avoid accidental deletion.

3.13.7 Combine Curve

Click menu [Handle] / [Combine Curvel, or click =t ,the following dialog box appears.
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Setting combine error @
Combine error(mm): | Y

I, Ok ] [ Cancel ]

The software automatically merge curves in the selected curves, when these curves merge tolerance

is less than the setting of combine error.

3.13.8 Bitmap Handle

Click A , and select a bitmap, then click menu [Handle] -> [ Bitmap handle] , or click System

BMP
Bar ™ .

Bitmap handle

Width: S00 Pixels
Height: 750 Pixels
H Resolution: Pixelsfinch
¥ Resolution: 96 Pixelsfinch
Brightness: 0.0%
y
Contrast: 0.0%
g
[Jinvert color
["]5et output resolution
=
Resolution{pixelsfinch) |=°
[CJoither
Net araphic
[ Apply to view J [ Apply to source ]

[ Get outline ]

A 728 www.01w com
—_—

I I[Saveas ][FuIIScreenH Ok ][ Cancel l

In the top right of the dialog box displays the information of the current image.
Be noted that, the horizontal resolution and vertical resolution is changing with drag scaling.

[ Apply to view J: Current settings is only used for preview, without affecting to the original
bitmap, press button [Cancell, bitmap will returned to the state of original image. Therefore, only
use for adjust effect. However, this approach requires more time and memory Space.

[ Apply to source): Current settings is use for original bitmap directly, so even finally click button

[ Cancel ], image will also unable to return to the original image. Therefore, it mainly used in
multi-step operation, and the current operation of this step is necessary to do, such as general pictures
must be transformed into gray scale. This can save the computing time of the follow-up operation.

[ Save as]: Retain the results of the previous operation, In addition to usingl Apply to view Jcan also

be exported. On this basic, to facilitate subsequent processing.
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[ Gray scale JGenerally, other image processing is based on the gray scale, so before handling, you can do a gray
scale processing, then click button [ Apply to source . For the gray scale than the color image occupied smaller

memory, for large image step by step handle, to a certain extent to avoid the lack of memory.
For color image, adjust contrast and brightness, have some auxiliary effect to following dither processing.

Adjust contrast:

Invert:

Sharp:

Before processing After processing

There are three method for dither processing: Net graphic. Dot graphic. Black and white
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Net graphic

Net graphic need adjust net size, better suited to material which is not high resolution, or the laser is

relatively slow to respond.

To get the appropriate net size, you can adjust resolution and net frequency of the image.
The higher resolution the more delicate.

The higher net frequency, the smaller net size. The lower net frequency, the bigger net size.

Generally, resolution of image is 500 - 1000, and net frequency is 30-40 lines

w5
I

Dot graphic

b
(93033920 c3¢
[$0183920145¢ 3¢
CUOUURIE

Dot graphic performance of good gray scale, better suited to material which is high resolution, and

the laser responds fast.

Black and white

In most cases, the effects of color image into black and white image is poor,, however, for some clear

outline image, is very easy to use.
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Get outline:

Bitmap handle =3
Width: 52 Pixels
Height: Pixels
H Resolution: Pixelsfinch
V Resolution: Pixels/inch
Brightness: 0.0% =
J Zero
Contrast: 0.0%

0

[Tl nvert color

7] set output resolution
Resolution(pixels/inch) | 1000

Dither

l Apply to view ] [ Apply to source ]

( Get outine |

[ |[ Fuisaeen ][ saveas ][ ok [ cancel |

Click “Get outline” button to extract the contour graph. As following picture

3.13.9 Processing preview

Click menu [Edit] -> [Preview] , or click System Bar =
-

sie
Total tine
Light tine
Ta. interval

Position 0.0mm,0.0mm
o

Progress !lIIIIIIIIIIIIIIII

Defalt

A=
ofls

Simiate ;

| [ TR

Software supports the preview of the documents to be processed, and you can get some basic
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information through the preview. For example, the path of the actual output of the processing,

general processing time, processing the distance. The machining process can be simulated.

In addition to the current edited file preview, you can also preview the files have been saved as rd.

Preview rd file:

Double-click in the graphics display area. Choose the graphic you want to preview in the pop-up dialog box. And

then open

Open P
Look in: ‘7,5 My Documents v E € ? bl

() Adobe Scripts )My eBooks [0 Source Insight
()Baidu )My 150 Files [ visual Studio 2008
() Corel User Files Ay Music D FEEINI
(CS)FILTERIT4 User Settings ([} My Pictures

[C)KSDStore )My QQ Files

(C3)My Designs @My webs

< ;
File name: “ ’ | Open l
Files of type: \ *1d v ; [ Cancel ]

[] Open as read-only

Software also supports to set the parameters of preview

Right-click anywhere in the graphics display area, the configuration menu will appears.

Select “Config” , pop-up following dialog box

Full window
Config

Vertical mirror

Horizontal mirror

You can preview the color of graphics to match the actual output of energy. Users can easily view

whether the layer energy is true.

Configuration @

Back color:

Backaground

Draw color{Power)
ow || W oo

Simulate color{Power)

0% i 100%
[T B

Font color: .

Idle color .

Anchor
() Top left () Top right
(O Bottom left (O Bottom right
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3.13.10 Data check

Selected to check after the graphics, click on the menu commands [Handle) / [ data check ] ,

or click system toolbar & .

Data check @

(Close check end ‘

Check close Mot find unclose curves
I 1 |Self-cross check end
=l q |
[Jauto close Error(mm): | | |Not find self-cross curves

|Cross check end

Chackcek ctocs Mot find cross curves
|Overlap check end

Mot find overlap lines
Check cross
Check overlap ‘
[T]Enable error Error{mm}); : Check

Data check, integration of the closed inspection, the inspection, the inspection, the intersection
of the fellowship data overlap a check. The user can select a check, inspection to the problem after
data, will be in the dialog box right tip have been found and, at the same time, the problem in
selected state graphics. Check-> ruled out repeatedly error-> inspection process until all the data are

conform to the requirements of the processing.
3.13.11 Generation parallel lines
Selected to create parallel lines after the data, click on the menu commands the [Handle] /[ Offset

poly] , or click system toolbar S

Offset poly

=X =) N

—
Offset(mm): |0-1] [ ] Delete artwork /
setimm k ‘ mm elete ariwor Z///? 7 L (\\:\\&
®1In Oout O Auta Injout Z/// - e
[ Ok ] [ Cancel ] < ﬂ/ \\/\i e S

Red line in the figure for the original graphics, green line is inside shrink graphics.
3.13.12 LGP design

Click the menu commands the [edit] /[LGP design 1 , or click drawing toolbar, already can start
reflex block design tools, the tools are specific to block the sun processing, is an independent functions,

such as the user is not involved in the sun block can be ignored this section processing content.
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Play channel tabula rasa design tools, we first need to design a reflex guide the outline.Play channel
tabula rasa design tools, we first need to design a reflex guide the outlinPlay channel tabula rasa

design tools, we first need to design a reflex guide the outline.

In the tool, the default created a 200 X200 rectangular guide tabula rasa outline. The user can in the

tools of "system" page manually create a standard to the shape of the guide tabula rasa outline.

Parameter | Output |System

LGP cut/Engrave
Speed(mm/s): 100.0 Default
MinPower(%): 30.0 Default

MaxPower(%): 30.0
V|Is blower on

Scan precision 1016 dpi
OnDelay: 0.000 ms
OffDelay: 0.000 ms
Outline cut
V| Enable outline cutting ¥|1Is blower on
SOftware alSO Speed(mm/s): 100.0 Default
. MinPower(%): 30.0 Default
supports the design of MaxPower(%): 30.0
o o OnDelay: 0.000
light guide plate made e o
OffDelay: 0.000 ms
of export to RDWorks AlTay paraeters
XNum: 1 X Space: 0.000
main  program for ¥Num: 1 ¥ Space: 0.000
processing
‘ Create LGP ‘

Position:‘Current Posit VH USB:Auto

I
‘ Start HPause/’Conhnue H Stop ‘
[ saveuFie | outputFie || Download |
| Goscale H CutScale H Preview ‘
‘ Export LGP design ‘

LGP CADBCAM System

Puraeter | Dutput | Systen

Width: 200.000  Height: 200.000
]Lockratio

Apply

Create LGP outine

width: TEH] | Heght: 200.0
O Rectangle Eipse

Apply

Enable LGP biank

Distance: 0.0 m

Ingort artwork

Create LGP

Postion: Qurentosit v)[  UsBiauto

Stat |[PausefContine | stop
savelFle || OuputFie || Downioad
Goscae [ cutscae || Preview

Expart LGP design
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Create LGP outline
Width: 200.0 Height: 200.0
@ Rectangle ) Ellipse

Apply J

Create standard setting the outline can use rectangular or oval. The user can also import a good
graphic design, as the outline of the sun. Click on the "introduction to guide tabula rasa contour"
button; can choose to have the outline of the document as the sun. Need to point out that outline file
must be closed graphics; otherwise, the system will automatically deleted.

LGP Size(mm):
Width: 200.000 Height: 200.000

(V] Lock ratio

Apply

If the outline of import size requirements, users can also
change size outline, and can set up if stay white edge.

Outline graphics ready, they can start on the tabula rasa increase network.

Parameter |Qutput | Systen |
‘ p y . . . . . M 1 4
i l Network is divided into six ways:horizontal,vertical line,

LGP type: elliptical, rectangle ,reticle and the grid.

Width: L0000 | Height: 1.0000
UpGrad: 0.0000  UpGrad: 0.0000
DownGrad: 0.0000  DownGrad: 0.0000 baseline position according to time light source. In the figure
LeftGrad: 0.0000 LeftGrad: 0.0000
RightGrad: 0.0000  RightGrad: 0.0000

Baseline related with light source, the user can adjust the

above red graticule marker is the baseline, users can move the

mouse to baseline, press the mouse, and then drag the baseline

Space(mm)
Up: 12,0000 i 0.200 to want to position.
Down: 2.0000 Grad: 0.2000
Lefiz|| 2.0000 Grad: 0.2000 The entire guide baseline reflex is divided into four
Right: ~2.0000 Grad: 0,200 . , . , .
regions, level above baseline definition for uplink and downlink
Base line

X 0,000 ¥: 0,000 below defined as; Vertical baseline definition for the left column

Dislocation — on the left, the right to define right column.
[V|Row ¥} Column

Light source — Set respectively size and spacing network respectively in
[T Left || Right
[Top [/Bottom up, down, left column, the right column initial value and the

gradient of the change, can form users want to conducting

l tabula rasa effect.
Create LGP

. For grid way, must set exercise can/column that can, can
Positons| Curent Post v~ UsB:Auto

[ |
’ Start HPause/Conh’nue " Stop J appear the grid.
| savetfie || ouputFie || Downoad | For the convenience of application, the system to provide
[ oSk H Gt ” Previen ' the light setup, if the light source is a standard, can choose the
[ Export LGP design ]
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Grid way Elliptic way

Reticle way Rectangle way

Horizontal line Vertical line
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Left light source

Top Light source

LGP cut/Engrave

Default
MinPower(%): 30.0 Default
MaxPower(%): 30.0

V|1Is blower on

Speed(mm/s):

Scan precision 1016 dpi
OnDelay: 0.000 ms
OffDelay: 0.000 ms

Outline cut

| Enable outiine cutting {¥'|Is blower on

Speed(mm/s): 100.0 | Default
MinPower(%): 30.0 Default
MaxPower(%): 30.0
OnDelay: 0.000 ms
OffDelay: 0.000 ms
Array parameters
X Num: 1 X Space: 0.000

Y Num; 1 Y Space: 0.000

{ Create LGP

Posiu’on;&CurrentPosit '“ USB:Auto

Export LGP design

‘ Start J ‘ Pause/Continue H Stop

‘ SavelFile H QutputUFile H Download
{ GoScale H CutScale H Preview
|

Right light source

Bottom light source

horizontal, vertical Line, reticle, elliptical, rectangular way is the network

scanning mode of output.

Scanning mode, the minimum energy, maximum energy general is
same, and dedication of the delay is 0. By adjusting the scanning system
precision, to adjust the scanning of the density, the more accurately the
scanning scan line secret, scanning the lower accuracy the scan lines

sparse.

The grid processing methods is cutting, and scanning not precision,
and can be adjusted according to the actual effect, the maximum and
minimum energy energy light switch delay, generally speaking, the least

energy slightly lower than the maximum energy.

If need to cut the reflex the outline, make can contour cutting. About
cutting parameters and common cutting Settings identical, in hereby

here.

If need to press array in the way processing more panels, can be set to
array parameters; Array direction along the machine is always the origin

in the opposite direction.
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Il Chapter 4 System Settings

Before output graphics, required to determine whether the system settings are correct. Click

menu [Config] -> [System Setting ]

Config(S) | Hande(W)  view(\y

Systemn Setting
Filz Para Setting

Page Setting
Password Setting .

Graph Hatch
Show Array
Show arid

4.1 General settings

etting
General settings | System Info
Axis Mirror Laser head
: =, || Absolute coordinate
[V] Axis X Mirror © © @ e
- D O € Map for pen axis:
[¥] Axis Y Mirror
[V] small circle speed limit || Scanning(Reverse interval
Diameter (mm) Speed(mm/s) Speed(m... Reverse... Offsetr...
1,100 10.000 50.000 11.000 2.000
2.100 20,000
3.100 25.000
4,100 30.000
6.100 35.000
8.100 40.000
< | 1 | » < | m | »
| Add.. | | Deete | | Add.. || oDe |

Axis Mirror

Generally, Axis direction of mirror is based on the actual location of the limit or home of

machine.
The default coordinate system if Descartes coordinate system, and zero in the bottom left.

If the zero point of the machine is top left, then X-Axis do not need to mirror, but Y-Axis need to

mirror.

If the zero point of the machine is top right, then both X-Axis and Y-Axis are all need to mirror.

71



User’s Manual of Laser Engraving / Cutting machine

In addition, this function can also use to other application for mirror.

F Default - = =s

File() Edit(E) Draw(D) Config(S) Handle(W) View(V) Help(H)

LoHEF00aaaaaaamoes ~wmEakHamB [ %%

x [-0.087 |mm f=[3.624 mm|[100 | o [ o ) | I ‘ ————— —— — ‘
ot oo i« W OL Frewwl |[B S m R 8| xal @K ANMIKH| i s e o
D .2:593 R T ) .Z:W e M o W .1-.5W PSR i W .l:m A W .“:SW T i I .“:m VR B ‘.“:5m DRI B lem = s H
~ | Work [output [Doc [user [ Test [ Transform|
’B d Layer Mode  Speed  Power  Output
71
v
=1
in]
Pt
®| ]
z Up Down
fI 3 o et E :
3% | by L Num  space Dislocation  Mirror
E [ 0.000 [0.000 n v
] v: [1 0.000 |0.000 H v
1 885)( Virtualarray || Bestrew.. Adjust
;
1 E 4

Laser work
[ st ][ Pausefcontiue |[ stp |

[ SaveToUFile H UFileOutput H Download ]

LWk A
1500,

3} ["]Path optimize Cutscale
o [ Output select graphics =
ooo | Q] Device
oog (O o
oo | _g: iy Position: Current position v
7 USBiAuto )

‘EEEET EEENEN ¢ DEEOE

Laser head

Position of Laser head means the location laser head relative to the graphic.

Top Left Top Middle Top Right

|
Middle Left Center Middle Right
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09 OOJ OOJ
00 00 00
l

Bottom Left Bottom Middle Bottom Right

When you intuitive view, just look at the zone where the green point appears.

Absolute Coordinate

You can directly check this option when you want the graphics location in the graphics display area
correspond to the actual work location of processing. Then the graph position will no longer relate
with the actual output position of the laser head and orientation point, but always regard mechanical

origin as the anchor point.

Put pen to paper axis mappings

If machines have been installed the life platform, and need for processing on different platform
height

Small Circle Speed Limit

On processing work , the software automatically determine whether the current round need to limit
speed ,then according to the diameter size of the circle to determine the speed. If parameter

configuration appropriate, will greatly enhance the quality of small round. Click button [ Add ],
[Delete] , [Modify] to configuration.
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Small circle is less than speed of the rules limiting the list of small round circle of minimum

radius, minimum radius circle at the speed of the output of the corresponding.

If the speed greater than maximum speed limit list the speed round, the speed only associated

with the speed of the layer.
If the speed is in the list, set the output speed by list.

If the request received by limiting layer parameters faster than the speed set in the layer, press

the speed of the output layer.
Scan backlash

Laser scanning graphic way, because the relationship between the machine belt tension may cause
the edge of the scanned graphics uneven. Therefore, increasing backlash to fix. It has the specific

backlash for the certain speed. General, the greater the speed, the greater the backlash.
(1 Add backlash

Click the Add button, the screen will pop up as shown in Figure
- Scanning(Reverse interval)

Speed(mm/s) 1
Reverse interval(mm) 0

Offsetrepay(mm) 0

[ Ok ] [ Cancel ]

Set speed and backlash, click OK, the value to be inserted into the list of backlash.
(2 Modify backlash

Double-click the left mouse button scanning (reverse gap) need to modify the reverse block

entry clearance, then the pop-up screen shown in Figure.

Scanning(Reverse interval)

Speed(mm/s) 50
Reverse interval(mm) 11

Offsetrepay(mm) 2

[ Ok ] [ Cancel ]

In the interface can modify the current speed of the corresponding backlash.
(3 Remove backlash

Right-click scanning (reverse gap) block in the backlash to delete the item, then click the [Delete] button.
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4.2 System info

Setting

| General settings | System Info |

Vendor password: ‘ Input

Mainboard version: ‘

I Upgrade

Information on the operation of the motherboard manufacturers need to enter password to view

parameters.

Setting

General settings | System Info |

Total on time{hour:min:s): l

Total processing time{hour:min:s):

Previous processing time{hour:min:s:ms):

Total laser on time{hour:min:s):

¥ Total travalim):

Y Total travel{m):

|
l
Total processing times: ‘
|
|
Mainboard version: ‘

’ Upgrade

Total on time: The total time of motherboard working

Total processing time: The total time of processing ,including the time of jump moving.
Previous processing time: The time of the last processing

Total laser on time: The time of the laser processing

Total processing times: The number of completed processing, not include the processing forcing to

end.
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X total travel:  The total travel of motor X.
Y total travel: The total travel of motor Y.
Motherboard version: The version of the current controller.

The function of upgrades:

If the board has additional features, the manufacturers will provide the update file (*. bin
format), the user can load the upgrade file to upgrade the motherboard. After the upgrade, you need

to click on the control panel "Reset" button reset the motherboard before normal use.

4.3 User parameters

Work lOutput I Doc i User lTest |Transform“

=] cut parameters A
Idle speed(mmjs) 300,000 ‘
Idle Acc(mmjfs2) 2000.000 :
Idle Delay(ms) 0.000
Start speed(mm/s) 20.000 L8
Min Accirmm/s2) 500.000
Max Acc(mmfs2) 2000.000

Acc factor(0%-200%) 80
GO Acc factor(0%-200% 120
Speed factor(0%-200% 80
Key setting

= Sweep parameters
¥ Start Speed(mm/s) 20.000

w Cravk Crnmmdfrara (Y 20 0NN

Open Save Read Write

Reading the board parameters must before operating the user parameters.

4.3.1 Cut parameters

==l Cut parameters A
Idle speed(mm;s) 300.000 ‘
Idle Acc{mmyfs2) 2000.000
Idle Delay(ms) 0.000 =
Start speedimm/s) 20.000
Min Acc(mm/s2) 500,000
Max Accirmm,s2) 2000.000

Acc factor(0%-200%) 80
GO Acc factor(0%-200% 120
Speed factor(0%-200% 80
Key setting

Idle speed: this parameter decides the max. speed of all lines not emitting beams during the
operation of the machine. This parameter should not be lower than the lower of the jump-off speed of
the X-axis and that of the Y-axis and not exceed the higher of the max. speed of the X-axis and that

of the Y-axis, if the setting is illegal, the controller will automatically set this parameter within the
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range above; a comparatively high idling speed can shorten the operation time of the entire figure
while excessively high idling speed may cause dithering of the tracks, therefore, you should take all

relevant factors into consideration when setting.

Idle Acc: Corresponds to the acceleration of the speed of air travel time, air and air-way-way
speed of acceleration to match, if you set too slow the actual speed may not reach the air-way set
value, if set too fast, they may not withstand the mechanical structure, resulting jitter . Slightly higher

than the general acceleration of air-way cut acceleration.

Cutting Acc: Corresponding to the acceleration of the speed of cutting (cutting speed is the speed of

the layer parameters of the layers).

Acc factor: the corresponding coefficient of empty walking speed,the greater the ratio,the greater the

idle speed.

Go Acc factor:Corresponding coefficient of cutting speed,the bigger the ratio the greater the cutting

speed speed faction: Rount the corner turning speed,the greater the coefficient is larger.

Turning speed: Turning the corresponding deceleration in the cutting process, the minimum speed of the drop,

when processing a lot of teeth when the graphics may be appropriate to reduce the turning speed.
Turning Acc: Should match with the turning velocity.

Cutting mode: Split precision cutting, fast cutting, ultra-fast cutting, the user can choose according to
the actual applications. Such as the emphasis on accuracy, select the precision cutting, such as

emphasizing speed, select the fast cutting.

Acc. mode: this parameter decides the acceleration and deceleration mode (S mode or T mode) of
the motor during operation, the motor accelerates and decelerates slowly and smoothly in the S mode

and fast and relatively unsmooth in the T mode; the default mode is the S mode.
4.3.2 Sweep parameters
=] Sweep parameters

¥ Start Speed(mm/s) 20.000
y Start Speed(mm/s) 20.000

¥ Acc(mmyfs2) 3000.000

y Acc(mmyfs2) 2000.000
Line Shift Speed (mmjfs) 150.000

Scan Mode Cornrnon Mode

Facula Size{S0~99%) 93.000

x Start Speed, y Start Speed: Off scanning speed in the use of stepper motor drag, do not began to
accelerate from 0, but can start work directly from a speed to shorten the overall processing time, but
the speed is not too high, and because the X, Y axial load is different from the rate, general the initial

speed of X-axis slightly higher than the initial speed of Y-axis

x Acc, y Acc: With the scanning speed (the speed of layers in the layer parameters) to match, if
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set too small, the scan speed to a longer distance, the scanning efficiency. The machine can be set
according to the actual structure, load conditions vary. Since X, Y axis load, generally much higher

than the X-axis Y-axis accelerometer.

Line shift speed of scanning: this parameter is specially used to control the max. speed of the
scanning to shift vertically from one line to the next line below it. If during the scanning, the line
space is too large or the block space is too large when scanning block figures while precise
positioning for each line or block is required, you can set the line shirt speed of scanning to a
comparatively low value. This parameter cannot be less than the jump-off speed of the corresponding
axis during the line shift and cannot be higher than the max. speed of the corresponding axis during
the line shift, if the setting is illegal, the controller will automatically set this parameter within the

range above.

Scan mode: There are two modes for your selection: the general mode and the special mode, in the
general mode, there’s no any treatment during the scan, in the special mode, light spots will be
treated. If the special mode is activated, the power of the laser should be increased and
correspondingly, the light spot percentage will be lower and the laser power attenuation will be
higher, to achieve the same depth of scanning, the laser power should be higher. The purpose to
select the special mode is to make the laser to emit beams at high power and in short period, during
deep scanning, the effect of flat bottom can be
achieved, however, if the light spots are improperly adjusted, this effect may not be achieved and the
working mode of high power and short period may influence the service life of the laser. The default

mode is the general mode.

Facula Size: When scanning the general pattern of selection, the argument is invalid, when you select
a special mode, the onset of the parameters. Control the parameters of control in 50% to 99%,

respectively.

4.3.3 Home parameters

=] Home para
Horme speed(mm;s) 150.000
Auto home X Mo
Auto home Y No
Auto home z Mo
Auto home U No

Home speed: This parameter determines the machine is turned back to the origin when the speed of a

larger format if the machine can be set to reset the speed is too large, but not too much.

X, Y, Z, U Auto home: The axis can be set whether should reset at boot time.
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4.3.4 Feeding parameters

= Feeding para
Delay before feed(s) 0.000
Dealy after feed(ms) 0
Progressive feeding No
Progressive feeding repa 0.000

Delay before feed:when using the feeding device,a single delay before feeding,the user can arrange

such as sorting material at this time.

Delay after feed:refers to material feeding device to reach the designated position,need stability for a
period of time before processing.

Progressive feed: feed uni will material sent to in place of one line is a way of feeding.

Progressive feed repay:in the use of feeding device there may be some error on line by line feed
4.3.5 Go Scale parameters
[ Go scale para

Go scale mode Close laser
Go scale blank{mm)  0.000

Go scale mode: Points of light to go off the border, the opening cut borders, corners three modes.

Go scale blank: Walking frame can be based on the actual image size up and down again about
the direction of some of the white left side of the border in order to ensure complete contains the

actual graphics.

This setting is on the control panel to go with the border-related functions, while walking on the

border with the independent software.

4.3.6 Other parameters

=] Other
Array processing Bi-dir Array
Return position Origin 3
Focus depth(rm) 0.000
Backlash X(rmm) 0.000
Backlash ¥ (mm) 0.000

-

Array mode: you can choose the swing mode and the one-way mode. The Swing mode: cutting the
array back and forth in order; the One-way mode: always cutting the array from one direction to
another. If One-way mode is selected, all array units have the same movement modes and the same
liquidity of movement, however, this mode will take more time than the swing mode. The default
mode is the Swing mode.

Return position: You can select the locating point and the machine origin. This parameter decides the
position, the locating point or the machine origin, where the laser head stops upon completion of

each operation.
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Delay before feed: Using the feeding device, the delay before a single feed, users can arrange the
time and the like, such as picking process.

Delay after feed: Refers to the material sent to the feed device in place, the need for stability after a
period of time for processing.

Focus depth: Auto focus operation to find the corresponding panel.

Backlash X, Y: Used to compensate the backlash caused by the machine drive problems.

4.4 Document Management

| Work | Output| Do |User | Test | Transform |

Number File Name Time(H:M:5:MS)
[ Read ] [ Process ] [ Download ]
[ Delete ] [ Cal time ] [ Upload ]
| Delete Al ]

Read

Click button Read, the software will communications with the controller, read the list of files on the
controller.

After read controller successful ,file information will be displayed in the document list.

Download

Click button Download, will pop up the file dialog , select *.rd downloaded file, then the file will be

downloaded to the controller.

If the download is successful, the document list will update.

Process

Select the file to be processed from the document list ,and click button Process

The controller will start the specified document.
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Delete
Select the file you want to delete from the document list, and click button Delete
The controller will delete the specified document.
If the deletion is successful ,the document list will be updated.
Delete All
Automatically remove all file in the controller, and update the document list.
Cal time

Motherboard supports processing files towards hours worked. Select the file to calculate the
work hours worked and click the button. Calculation to be completed, the control panel will be
prompted to complete the calculation. And then point to read button shown in the list, calculated

from the working hours.

In addition, when the document processing operation performed, the hours information will also

be covered by the actual processing work.
uploading

On the main board of the selected from read offline files, and saved to the computer.

Il Chapter 5 Processing Output

~

Laser work

- ]
| _P .
Start ” Pause/Continue ||  Stop — Processing control

| saveTourie || UFieOutput || Download |

Path optimize 1\ Cut scale |

-

Output select graphics L Cacate J
Device
Position: LCurrent position v]
USB:Auto } » | Search device

5.1 Search Device
Link device in two different ways: USB and network. But through USB port button on the popup
dialog box, set connection mode and choose connection port.
Current Position : Laser head back to the position before processing.
Original anchor : Laser head back to the last anchor ,the anchor may set at panel.

Machine zero :  Laser head back to the zero of the machine.
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Device
Position: Current position ¥
Current position
[ LoEgulo Anchor point
Machine zero
= .
S USB port setting S
S ™M
® uss: Add || Delete || odnfy—]- e
Machine Port m—
PortNO: |[COM3 v | Test
v machine Auto —_—_— = i\ J
ok ][ come
Web: [ Add || Delete |[ moafy | 1P address setting %
Machine P
v machine 192 162 1 100 -;'o:fnr‘m: machng e
p 92.188. 1 100 | Test
(o] (e,

If the computer connected to a laser device, option can be set to automatically, the software will

automatically determine the determine the connection with the device interface

When computer connection has many sets of laser equipment, click add, new can, need to use which

device, click the check box

Click on [addJor [modify]),can him out of the dialog box as shown above toladd] or [modify]

can click on the [test] ,after testing whether the connection is successful with the device

Network: If the computer is connected to laser device, click on the add ,enter to connect machine

name and IP address of the equipment

When a computer is connected with many sets of laser equipment, click add, which can use new

device, click the check box

Click on thel add Jorl modify Iwill he a dialog box as shown above tol add Jorl modify Jafter clickable

[test] detect and equipment connection is successful

Search at present already connected device, and choose from the drop-down list corresponding IP

address machine.

5.2 Layer processing

First, in the menu [Handle] -> [Path optimize] check “according to layer order”, then click
“OK” to exit.
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Layer reorder: Click button Up, Down can change the order of layers, or direct the mouse to

drag the layer to the specified location.

Here, you must check the “Path optimize” option.

5.3 Position
Setting the laser head back location after processing completed.(Current position. Original anchor.
Machine Zero.
Current Position : Laser head back to the position before processing.
Original anchor : Laser head back to the last anchor ,the anchor may set at panel.

Machine zero :  Laser head back to the zero of the machine.

5.4 Go Scale. Cut Scale

For Example Go Scale, As the following figure shown, the actual graphic is round, and the red
rectangle outside the circle is the smallest rectangle, click button Go Scale, laser head will run once

along the rectangular path.

For Example Cut Scale, As the following figure shown, the actual graphic is round, and the red
rectangle outside the circle is the smallest rectangle, click button Cut Scale, laser head will be cut

along the rectangle.

5.5 Start. Pause. Stop. Save To Un File. Un File Qutput. Download
Start: Output the current graphic to the machine for processing.
Pause\Continue: Click Pause, will stop the processing work , click the button again to Continue
Stop: Stop the current processing work
Save To Un File:

Save current file as RD format, using for offline processing (Can be copied to other memory board

for full offline operation).

Un File Output:

Output the offline file (RD format)

After save offline file, click Un file Output to select rd file to processing.
Download:

Download the file to the memory of the controller , then user can start the file through the machine panel.
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5.6 Output select graphics

After check Output select graphics, then only output the selected part, rather than not output the part

not selected.

5.7 Path optimize

After check Path Optimize, then automatically perform the path optimize before the output.

If has done the Path optimize or not need optimize, then not check Path Optimize can reduce

waiting time.

5.8 Test

Work | Output | Doc User Test Transform

[ Current Position J

N ) s

b
'
Z

Axis Move
Offset{mm): 10)
Speed(mm/s): S0
l-lome” x+ H-iome Power(%): '0

["IMove from origin
[ 1F Light

Axis control, can only control one axis each time. You can set the information for axis move,

E

including move length. speed. laser on-off and laser power.

If you check “Move from origin”, then the offset you set means the offset to machine zero.
If you not check move from origin, then the offset means the offset to the current position.

The X-axis, for example, assuming the current position is 100mm, such as the step distance is set to
10mm, then the exercise once, the new location will be 110mm, such as the check moves from the
origin, movement time, the new location will be 10mm, and repeated Movement, location will no

longer change.

Note: According to the provisions of the controller, the absolute position is no negative in the whole
breadth. If you check the Move From Origin, and set the offset value negative, then the machine will

hit limiter.
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5.9 Output Setting

Work | Output | Doc User | Test | Transform

[]Enable rotate engrave

Circle pulse:

Diameter{mm):

Speed{mm/s): 7

[JEnable feeding
Feeding Count:

Distance{mm):
[]Backlash reapy optimize

[T]Enable offset of Laser2

X '

5.9.1 Rotating sculpture

[ Enable rotate engrave ]: After enable engraving, the actual precision of Y-axis will be based on
diameter and step per rotate to auto match the setting of pulse precision of Y-axis. In addition, the

work area in the main interface will also change.
[ Diameter): The diameter size of the parts.
[ Step per rotate ]: The number of pulse corresponds to the workpiece rotate one week.
[ Test] :The speed of testing work.
[ speed 1 : testthe speed of work.

The function is to facilitate the users to replace parts, and different size of the workpiece when
the workpiece is not very different before use. When the relatively large difference in size of the

workpiece, it is recommended to use directly modify the motor step approach to implementation.
Rotary engraving is only when using the rotation axis to replace the Y-axis use.

5.9.2 Feed Setting

To use the feed, must first enable the feed.

After set feeding parameters, the shaft will be feeding a feeding length, and repeat the process , until

the times of processing reach to number of feeding.
If the machine is not equipped with feeding devices, in general, enable the feed ban.

5.9.3 Optimization of Backlash Compensation
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When the machine there is space (such as dislocation of the seal cutting graphics), can be

checked.
5.9.4 Optical 2 migration

In need laser collaborative work, complete the same graphics processing occasions, usually, to
use the optical 1 to define the graphics location, then if the optical 2 can accurately with the optical 1,

will need to specify the optical 2 relative to the optical 1 offset.

This generally used in two power different laser tubes of machine, because two of laser tube

power different, cause different functions.

If some machines equipped with two different power of laser tube, a responsible for cutting, a

responsible for sculpture.

Work | Qutput l Doc [User l Test TTransformf ]

Layer Mode Speed Power Qutput
Cut 100.0 30.0 Yes

Cut 100.0 30.0 Yes
Cut 100.0 30.0 Yes

[ Up ] [ Down ]
Line/column setup

Num space Dislocation Mirror
x: 1 0.000 0000 [[FH [v
y: 1 0.000 0000 |[[CJH [Cv
{ Virtual array H Bestrew... ][ Adjust

5.10 Layer Settings

5.10.1 Ranks set

For convenient to set in machining graphics processing on the array.

X numbers and Y numbers, which was the array of columns and rows.

X intervals and Y interval, respectively is array of the column spacing and line spacing.
Interval and the adjustment of the dislocation is the arrangement of array.

Adjust the X, Y interval between enable graphic layout more closely, can be adjusted directly below
the interval and dislocation ,make graphics in the selected state, and then through the keyboard of the
up and down or so key to adjust, and rolling the mouse can be displayed scaling, make the spacing of
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the adjustment process more precise.

[ Bestrewing breadth ] :According to the size of the wide and the current user Settings ranks
spacing, to determine how much can output the most listed (i.e. X number) how many lines (i.e., Y

number). Click on the button [Bestrewing breadth] , pop-up interface as shown in figure:
Bestrewing breadth (S

X breadth(mm): 2|

Y braddth(mm): 2

[ Ok | ’ Cancel ]

According to determine the button, the software can automatically calculate the entire width of the

ranks of the arrangement number.

7 A ﬁ\\lj
p I/ A
3\ )
R B

[ dislocation ] : for some graphics, in arrangement, the dislocation arrangement, can make the

arrangement more compact.

[ mirror] :objects in a horizontal or vertical direction to reverse it

[ adjust):When arranged some of the smaller mobile can click on the adjustment to carry on the row

spacing and dislocation distance

[ virtual array ]: After good array,selected to copy the graphics,point to copy,can copy the patten

array
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Layer Parameter
L l [ Load parameters from library ]
- Is Qutput: |Yes |
Speed(mm/s): 100 ["] Default
If Blowing: |Yes [+

Processing Mode: | Cut v

Min Power (%) Max Power(%)

[#]1: 30 30 ["] Default
“]2: 30 30
Seal: 0.000 mm | Advance...
Open Delay: 0O ms
Close Delay: 0O ms

[V] Laser through mode

Through power: 50.0 %

z_’ l Ok ] [ Cancel ]

[ The application to copy 1 in good array, chosen to copy graphics, some application to copy,

already can duplicate array graphics.

In the layer list to edit the double click inside layer, namely will pop up layer parameter dialog

box.

The left article color, representatives of the current graphics layer, choose different color, can be

in already switch between different layer, one-time modified multiple layers of parameters.

The layer parameters is divided into two parts: public layer parameters and turn a layer
parameters.Public layer parameters is to point to no matter how the layer processing type, all

effective layer parameters;

Proprietary layer parameters is to point to the layer of processing type change of the

corresponding parameters will also be changing.

88



User’s Manual of Laser Engraving / Cutting machine

Laser Scan Parameters Setting

Layer Parameter

[ Load parameters from library J

aver: | L

Is Output: |Yes %

| |13

Speed(mm/s): 100 [ Default
If Blowing: |Yes v

Processing Mode: | Cut v

Min Power (%) Max Power (%)

v]1: 30 30 [| Default
V]2: 30 30
Seal: 0.000 mm | Advance...
Open Delay: 0 ms
Close Delay: 0O ms

[V]Laser through mode

Through power: 50.0 %

Laser: Software to distinguish between different layers of the graphics processing technology
parameters. For scanning processing methods, more are in the same layer bitmaps, and whole as a
picture output, if hope each bitmap single output, it can be a graph respectively placed in different

layer can.

Is Output: Have two options: yes and no. Choice is, the corresponding layer will output

processing; Choose no, won't output processing.
Speed: The corresponding processing method of processing speed.

For cutting processing is concerned, the slower, processing the better, the more smooth track; The

faster the processing results, the worse the trajectory smooth;

To scan for processing, the slower, under the same energy scanning depth, deep and scanning

trace the thick, scanning the resolution also reduced.

The faster the same energy the shallow depth of the scanning, details distortion increase.
To fix for processing, the main change is empty the speed of the move.

If, check the "default", the actual speed by panel set up to speed.

If Blowing:f the machine external fan, and fan has enabled, then if choose "is", then this layer
data processing, will open the fan, otherwise, will not open the fan. If you do not make can fan, no

matter choose "yes" or "no", are meaningless.

Processing methods: says the method of processing corresponding layer;
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If the currently selected is vector layer (i.e. color layer), it includes three choices: laser scanning,

laser cutting, laser rbi;

If the currently selected is a tutu layer (namely BMP layer), the only include a choice: laser

scanning.

Laser 1, laser 2: corresponding to the main board laser signals 1 and 2 of the way way laser

output. If it is only head machine, the second road laser meaningless.

The minimum power, the maximum power: the power of the values of the range of 0 to 100, said
that in the process of the strength of the laser processing; Big value, the laser is strong, is small, the

laser weak. Minimum power loss to the most power is less than or equal to.
For different processing type has a different meaning.

For cutting processing, the actual power is cutting speed and phase follow, speed, low energy is
also low, high speed is high also, so that we can guarantee the whole process of cutting energy
evenly.So the minimum power the speed of the corresponding minimum energy, the minimum speed
general is 0, but if set the speed is the minimum speed for takeoff take-off speed; The maximum

power correspond to the layer speed.
Set minimum power, and the most high power flow:

1> The minimum power and the maximum power set to the same value, synchronous adjustment.

Until all the cutting curve are already appear.

2> The maximum power unchanged, and gradually reduce the minimum power until the energy of

the heavy cutting curve at the lowest level, and all of the cohesion parts can be processed to come out.
3>If not yet to best effect, can be the most appropriate fine-tuning high power, and repeat step 2.

If is cut through, the minimum power loss and the maximum power no significant difference,

can be set to give the same.

To scan processing, ordinary scanning, the minimum power and the maximum power must be
consistent. Slope sculpture, minimum power loss is the power of the corresponding factors, the most

power is the power of the bottom of the corresponding.

bot tom¢

/

Minimum power loss is the top for the small slant wide, detail place distinguish clearly.

Minimum power loss is too large slope not obvious.
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To fix processing, the minimum power and the maximum power can be set to agree.
If checked "default", the actual power panel set by the power to determine.

Click the button "advanced", but also can be set to other layer parameters.

Open Delay: 0 ms
Close Delay: 0 ms
[¥] Laser through mode

Through power: 50.0 %

Seal:Closed cutting graphics seal is not closed condition ,can be closed with the sealing

compensation,but if the sealing is misplaced,there is no compensation,clearance compensation

optimization can be used to compensate,or use the backlash compensation in the user preferences

Open Delay; Medallion for a time / medallion latency

Close Delay:light off through wear / light off delay time

Laser through mode:If checked,the light switch delay said is on time,otherwise,the time delay switch

is light delay said laser movement
Through power:Refers to crush objects in unit time of the work done fast.

Other layer parameters @

["]Enable pen up and down
| mm

? mm
Speed:{mm/s):

Paint
Dot interval(s) a

Extend IO output

[0t

| Ok | [ Cancel ]

[ Pen up and down ] If machines have installed the lift platform, and need to be in a different

platform height on the processing, can make can write up function.

Here the corresponding is platform write position in which high on the processing, carried the
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corresponding is empty pen position before go, platform should be moved to which level in the
optical translation will not again to interfere with the process workpiece. If confirmed the optical not

and the translation of the process workpiece to interfere, don't need to set up the pen position.
Use way is:
1> Can write pen to carry.

2>Make can write position, manual control panel key mobile platform, to stay processing
graphics graphics processing plane, adjust the focal length. Then click button "read", and then write

all set up position.

3>That can carry a position, manual control panel key mobile platform, move to the optical will
not interfere with the work of the height, and through the panel key move the optical, confirmed that

won't interfere, some button "read", and then set up a position.
[ point]

Here the rbi, and is suitable for drawing tool create some primitive, or from DXF file into the
some primitive. And the current layer processing methods has nothing to do, namely whether the
current layer is cutting or a scan, graphics in the some primitive has always been to the rbi way

output.

The rbi movement speed for layer speed, beating the energy for the maximum energy layer

laser.
[ The laser Enable]
When the machine is equipped with two road laser, usually, are two road and output.
But the user may through the set that laser, that its not output all the way.
[ The joint IO output ]

All the way and the layer associated IO output, obligate function.

Other cutting param

[¥] Enable sew compensation

Direction: |Inward v

Sew width 0.1 mm

| Ok J [ Cancel ]

[ Enable sew compensation ] :Use seam width compensation can compensation caused by laser

cutting seam size of the graphics and graphic deviation of actual cutting out, Seam width

compensation applies only to closed graph

[ Sew Direction] :According to the actual need to set up,such as cut a round,if you want to keep the
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circle is cut off,you should set the direction of compensation to outward,If want to keep the

hole,should set the direction of compensation to inward.

[ Sew width] :Lase cutting seam width

5.10.3 Laser scanning parameters Settings

Layer Parameter 2] Tojer Parameter ==

i’ ‘ Load parameters from thrary ] A | [ Load parameters from library ]
— i

B e - —

‘ - Layer:
] Is Output: |Yes N ‘ Is Output: |Yes Y
Speed(mm/s): 100 | Default Speed(mm/s): 100 (| Default
IfBlowing: | Yes X If Blowing: |Yes v
Processing Mode: | Scan v [ Advance... Processing Mode: |Scan ~
Min Power(%) Max Power(%) Min Power(%) Max Power(%)
V1 30 30 || Default @1 30 30 Default
vi2: 30 30 vi2z 30 30
legative Engrave Optimized Scan [ |Negative Engrave [ | Optimized Scan
|| Output direct ["]1ndependent output [ Output direct ("] independent output
| |Ramp Effect [ | Ramp Effect
Ramp Length: 0 mm Ramp Length: 0 mm
Overstriking: |Un-process | v Overstriking: |Un-process |v
Scan Mode: | X_swing v Scan Mode: |X_swing e
Interval(mm): 0.1 Advance... Interval(mm): 0.1 Advance...

~] (o J[ea] |=] (o] o]

On the left of the dialog box for vector scanning parameters Settings, on the right side of the dialog

box for bitmap scanning parameters Settings.
The vector data do not support the scanning the color carving, optimization scanning, direct output.
The color carving: normally scanning, bitmap in the black spots a laser, the laser in white.

Choose the color carving, the bitmap in the white of the laser, black spots in a laser.

Optimal scanning: choose optimization will automatically adjust the users scan the scanning interval

to set up the best value, the scan best effect.

Otherwise, according to user Settings of the scanning interval scan pattern. Generally choose

"optimal scanning"

Direct output: gray scale bitmap, according to the actual graphics gray.in output, already color deep

place laser energy big, color shallow place laser
Energy is small.

Figure yuan respectively output: for vector graphics for, figure yuan respectively according to vector
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diagram output is the position of the yuan relationship, which in turn will get together the vector map

carving output of yuan respectively.

If not checked figure yuan respectively output, it will be the whole vector graphics as a whole

to sculpture.

For a bitmap for, if not checked figure yuan respectively output, the system will automatically

will work with a layer of the bitmap in as a whole output.
If checked the figure yuan respectively output, the system will be in a single output bitmap.
Slope effect: the scan the edges of the figure appear slope, submit stereo effect.

Be bold font: including don't handle, scanning the font, scanning the bottom. Generally choose not

processing.
Scanning is part of the font scanning is the font, also is the Yin carving.

Note that the slope effect choice, please will be bold font choose not to deal with, or slope affected
the effects.

Font Yin carved: not to add text outside the box, scanning are text itself, as below:

Welcome

Font Yang carved: text and the outer frame, scanning is the bottom of the graphics, as below:

M

Scanning mode: including level one, level two-way, vertical one-way, vertical two-way.

Level one way: the optical scan pattern back and forth in a horizontal direction, but only to a
direction when laser scanning comes out,Such as: when the optical scan from right to left a laser, and

from left to right the laser scan.
Level two-way: the optical horizontal direction in the back and forth laser scanning graphics.

The vertical one way: the optical scan pattern in vertical direction back and forth, but only to a
direction will be laser scanning,Such as: when the optical scan from up to down a laser, and from the

bottom to scan a laser.
The vertical two-way: in vertical direction the optical back and forth laser scanning graphics.
Note: general use level two-way scanning mode.

Scanning interval: namely the optical scan every much long distance under a line. The smaller

the interval, scanning the deeper to graphics; Conversely, the more shallow.

Suggestions: (1) for vector layer (i.e. color layer), scanning interval in 0.1 mm general set
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below.
(2) for a tutu layer (namely BMP layer), scanning interval in 0.1 mm general set above,

Then through the change and the most high power to make the minimum power after scanning

the graphics depth to achieve the ideal effect.
5.10.4 Laser Dot Parameters Setting

Layer Parameter @

Loyer: [ I

Is Output:  Yes v
Speed(mm/s): 100 [JDefault
If Blowing: | Yes v

Processing Mode: Dot v

Min Power(%) Max Power(%)

Laserl: 30 30 (] Default The time for emitting laser on one dot during
Laser2: |30 30 the process. The higher the value is, the
darker the dot is; if reverse, the weaker.«

Dot time: 0.1 s
/ The interval between the dots«
Dot interval: |SI mn
Dot length: 0 ——mm— 7| Dot length, for cutting dashline «
[]Center dot

e

Only dot at center«

[ Ok J [ Cancel J

5.11 Vendor settings

5.11.1The motor parameters

XY Z U axis parameters

Dir polarity: Change the direction of polarity can make the motor to the reverse direction. Modify
the goal is to make the shaft to the origin when reset, if reset when the axial direction away from the

origin, explain the polar axis direction set wrong, should be modified.

Limiter polarity: Used to set the limit of high and low level signal model, If moving axis reaches
the limit position ,enter a low level signal to the main board ,the limit should be set to a negative

polarity

Breadth: The longest distance between the axes can walk, according to the actual situation of the

machine
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Home offset: If the shaft can make the hard limit protection, often should set the value of 2~5mm,if
set to O,then the axes coordinate zero run to minimum, effective, has the potential to limit such
trigger error limit protection function, emergency stop the machine, if can not make the hard limit

protection, can set value is O~5Smm.

Contrl mode: Double pulse and pulsetdirection mode optional, depending on the of motor drive

machine actual configuration decision, general model for pulse+direction

Step length; Namely motor pulse equivalent, send a pulse to the motor, the corresponding motion
axis through the absolute distance value. Before this value is set up correctly, can let the machine
cutting a large rectangular (graphics is bigger, can make the error smaller), automatic calculation by

graphic length and measuring the length of the step motor.
Enable limit trigger: Whether used for enabling the axis of the hard limit protection function.

PWM rising edge valid: Used to set the motor drives the pulse signal is rising falling edge along the
efficient or effective, when not enabled the falling edge controller using effective; When this is

enabled, use the rising along the effective controller.

Enable Home: If machine configuration with the shaft, the shaft "reset enabled" option should be open,
if not configured the shaft, then the shaft "reset enabled" option should be banned. The meaning of this
parameter is to control the "reset" boot options in the user preferences and function keys in the "reset" the

axis function, prevent users mistakenly to reset the shaft moving that doesn't exist.

Jump-off speed: Movement speed of shaft directly start from stationary state, if the value is too big,
can lead to motor lose step, jitter, and even produce the noise and set is too small, can reduce the
running speed of the graphics. The heavier if the large inertia of moving axis (axis), can install a
smaller takeoff speed, if the movement axis of inertia smaller lighter (shaft), can be appropriately

increase the rotate speed. Typical values such as 5 ~ 30 mm/s.

Max speed: The shaft can withstand maximum speed. The parameters and inertia motor drive power,

motor shaft, and gear ratio. Typical values such as 200 ~ 500 mm/s.

Max Acc: Motor shaft in the maximum acceleration and deceleration motion, acceleration set is too
large, also can lead to motor lose step, jitter, and even produce the noise and set is too small, can lead
to speed up slow and reduce the running speed of the graphics. Corresponding to the large inertia
axis, such as beam of the Y axis, a typical setting for the range of 800 ~ 3000 mm/s2, corresponding
to the axis of inertia small, such as the car of the X axis, a typical setting range is 8000 ~ 20000

mm/s2

EStop acc: Can make the hard limit protection, if the shaft, when the axial movement to the limit
position, to the shaft to stop operation for emergency stop acceleration deceleration. This value may
take the maximum acceleration of 2 ~ 3 times

Keying

Jump-off speed: Keys on the keyboard to move the axis movement starting speed, not above the
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shaft rotate speed

Acc: Buttons move the axis motion acceleration value, cannot be higher than the maximum

acceleration
Invert direction:

Used to control the movement of the manual button when the mobile movement axis direction. When
set the right direction of polarity parameters, if press the direction key on the operation panel, the

axial direction, which buttons can reverse.
5.11.2 Laser parameters

Laser config: Single tube/pipe is optional, according to the number of laser tube manufacturers

actual configuration Settings

Laser mode: Glass tube, radio frequency laser (don't need precombustion pulse) and radio frequency

laser (need precombustion pulse) optional
Laser attenuation. Min power. Max power. Laser freq. Preginition freq:

Preginition pulse: For radio frequency (%) laser and precombustion pulse, frequency and
precombustion by precombustion pulse width configuration precombustion characteristics of the

pulse.
Signal level:

Water protect: When can make water protection, the controller must be connected to water
protection circuit, the machine won't out of the light, if we do not make water to protect, don't pick

up the water protection circuit, the controller will not detect.

Laser frequency used by the control signal is used to set the laser pulse frequency, the glass tube,
generally set to about 20 KHZ, Radio frequency tube usually about 5 KHZ; Maximum/minimum
power (%) is used to set the limits of the laser power value, namely at runtime, users to set maximum
power can not be higher than the set value of maximum power, user Settings cannot under minimum
power value for the setting of the minimum power value; Use after a period of time, if the laser
power attenuation, is by setting the attenuation coefficient to fine-tuning of laser power, laser without

attenuation, attenuation coefficient of 0.
Prompt: If single laser tube is configured, it only shows a laser parameters
5.11.3 Other vendor parameters

Machine type: For the most part should choose general engraving machine, other models for a

particular model

Transmission mode: Under normal circumstances should choose "step type belt", choose other type,

control algorithm will have small change

Feed mode: A one-way/two-way optional. When for one-way feeding, do not check the coordinate,
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but has been unilaterally upward; When selecting a two-way feeding, the system will check the
maximum minimum coordinates, an odd number of times to one direction, even time to another
direction, first initial direction by setting the direction of polarity to change or modify feeding the

length of the positive and negative value

Broken delay: Can be set to 0 ~ 3000 ms. After power grid, the system power supply does not
immediately reduced to 0 v, during a time delay, the power set delay value should be the actual delay
values are basically identical. If the value is set, the deflection is in power to continue carving work,

a second processing of graphics and graphics or not closed before power, or too much overlap

Enable protect: If can make this, the controller must be open protection circuit is connected,

otherwise the machine will not work

Enable blower: If want to use the outlet Wind signal layer and control the fan switch, you must

make to the parameters, otherwise, the Wind signal output to other signals

Prompt: Manufacturers in the parameter configuration parameters, such as the direction of polarity,
control mode, the types of laser and laser frequency modified four parameters, it is necessary to reset

the system, reset after the completion of the changes to take effect.

lll Attached

Bitmap Creation Flow

Step one: Startup Photoshop

Step two: Select the menu File/Open to open a picture:
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Step three: Select the size and the precision of the picture

1. Open the menu Image/Image Size, a window will pop up, as shown below:

Pixel Dimensions: 1.57M i
woer: B0 | [oves M
Heoht:[800 | [pwes |-

Document Size:

Width: i&‘ |cm "} .
Height: | 28.22 m v] ]6
Resolution: | 72 ‘ { pixels/inch V‘

Scale Styles
Constrain Proportions

[v] Resample Image: \ Bicubic V‘

Figure 5-2

2. In the column Document Size/ Height and Width, input the value you wanted, figure 5-3 followed;
3. In the column Document Size/ Resolution, input the converted graph precision(600~1200 pixels

per inch is recommended, the higher resolution, the clearer converted graph);

Pixel Dimensions: 53.2M (was 1.57M)

width: (397 | [pres ]
Heght: (4724 | [oxes ]

Document Size:

width:[10 | [em Y|
Height: LJ ’ cm V}
Resolution: ' \pixels/inch V}

[[] constrain Proportions

Resample Image: [ Bicubic V‘

Figure 5-3
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Such as figure 5-3: the converted graph size is 10cm*12cm, the resolution is 1000 pixels per
inch;
4. Push on the OK bottom.
Step four: Select the menu Image/Mode/Grey Scale, take out the color information.

Step five: To create net-dot bitmap, two methods are discussed below:

Method one:

1. Select the menu Image/Mode/Bitmap, a window will pop up as below:

Resolution
Input: 1000 pixels/inch

IH
-~

Output: 11000 \ \ pixels/inch v‘
Method
Use: | Halftone Screen... v

50% Threshold
Pattern Dither
Diffusion Dither
Figure 5-4

2. Select (T) , (P) , (D) or (H) , which method is you wanted,;

3. To solid graph, Please select (T), to create some scan graph of the character or of the logo design.
To cross line graph, may select one of (P) , (D) or (H) , to create some different effect. Generally
speaking, select (H) .
4. if (H) selected, a window will pop up:

Halftone Screen

Halftone Screen

K
Erequency: | 30 ‘ ‘ lines/inch V‘
e Cancel
Angle: | 45 ‘ degrees

Load...

Save...

i
il

Figure 5-5
In this window, frequency (F), that’s to say, the precision of the cross line, may be 10~60 lines
per inch;
Angle (N) may be 45 degree;
In column Shape (H) , circle is selected generally.

5+ Push on the bottom OK.
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Method two:
1. Select Filter/ Pixelate / Color Halftone , a window will pop up, such as figure 5-6.
2. Confirm Max Radius, which is 4~127 pixels, to confirm the size of the color halftone gridding.
The calculating method followed: graphics resolution*0.71/ gridding precision.
For example: as shown in figure 5-1, the resolution is 1000 pixels per inch, the wanted gridding

precision is 60 DPI, then, the max radius is 12, the expression followed: 1000*0.7/60=12.
3. Confirm the net angle of the graph channels.

Input the net angle value for some of the graph channels, the angle is -360~+360 degree, which
is the angle of the net dot and the horizontal line.

Note:

To grey graph, only channel 1 selected;
To RGB graph, channels 1,2 and 3 selected, then red, green and blue channels are
corresponding;

To CMYK graph, all four channels selected, then cyan, magenta, yellow and black channels are

Color Halftone @

Max. Radius: '_'] (Pixels)
Screen Angles (Degrees):
Channel 1: 108 | Default

corresponding.

Channel 2: 162
Channel 3: frgo
Channel 4: '45
Figure 5-6

4. Push on the OK bottom,;

5. In the menu Image/Mode/Bitmap, Select 50% Threshold, to convert the graph to one-bit bitmap.

For example, after filter processing, the RGB graph, such as figure 5-7-1, will be converted

to a bitmap, as shown in figure 5-7-2.
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-
oy

e

a R

Figure 5-7-1 Figure 5-7-2

(1)Select Image/Rotate Canvas/Flip Horizontal to rotate the graph;

(2)Select the menu File/Save As to save the graph file, BMP format selected,
(3)All things are done.

Some methods of drawing in Photoshop aren’t discussed in this file, if needed, please

consult the Manuals of Photoshop or some related books.
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IV Instruction on the Machine Parts

IV.1 Front side of the Laser Machine

<20>

<21>

<11>
<12>
<13>

<14>
<15>

<22>

<16>

17>

<18>

<1> Control Panel <2> Emergency stop for control switch
<3> Y axis limit switch

<4> Y axis connector, you can easily to install the rotary attachment with it.

<5> X axis limit switch <6> X axis motor

<7> Laser head with Red light indicator

<8> Y axis motor <9> guideway
<10> led light <11> Udisk interface
<12> PC (USB) interface <13> Ethernet interface

<14> Motorized up&down switch (Optional)

103



User’s Manual of Laser Engraving / Cutting machine

<15> Control switch <16> Laser switch
<17> Water pump control switch

<18> Air pump control switch, some model machine using the same switch with

the water pump.
<19> Water pump joint <20> Air pump joint
<21>220V /110V power Input for machine

<22> Ground wire joint

IV.2 Back side of the Laser Machine

cover, you can see

(1) Exhaust fan (2) Water Inlet
(3) Water Outlet (4) Airinlet

(5) Water sensor switch
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IV.3 Control box of the Laser Machine

Y axis motor driver

X axis motor driver Focus motor driver (optional)

Mainboard

switch power supply
Filter Laser power supply
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Thank you for using our products .
The product content information to change without notice.

Users who have any comments or suggestions in the process of using
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